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2. Installing SpiraTeam®

This section outlines how to prepare your system for installation of SpiraTeam®, how to actually install
the software using the provided installation package, and finally how to ensure that your web-server is
correctly configured to ensure secure operation.

The first sub-section will outline what hardware and software configurations are supported and the exact
installation sequence for the different versions of Windows Server. The second sub-section will explain
how to load the SpiraTeam® software onto the server, and discuss common problems and solutions.

The minimum hardware and software requirements for running the SpiraTeam® system are:

Server Requirements

Requirement Minimum Specification

Processor: Intel® or AMD® x86 or x64 compatible processor
Memory: 2 GB, 4 GB recommended

Operating System: Windows Server 2012 R1 & R2 (recommended)

Windows Server 2008 R1 & R2 (recommended)
Windows Server 2003 R1 & R2
Windows 10, 8, 7 (for demoing)

Service Packs: Windows Server 2003 SP2

Database: Microsoft SQL Server 2016

Microsoft SQL Server 2016 Express Edition
Microsoft SQL Server 2014

Microsoft SQL Server 2014 Express Edition
Microsoft SQL Server 2012

Microsoft SQL Server 2012 Express Edition
Microsoft SQL Server 2008 R2

Microsoft SQL Server 2008 R2 Express Edition

Web Server: Internet Information Services (I1S) 6.0 or higher
ASP.NET Web Extensions 4.0 or higher

Client Requirements

Requirement Minimum Specification

Web Browser: Microsoft Edge

Internet Explorer 9.0+

Mozilla Firefox

Google Chrome (Desktop and Android)
Apple Safari (Desktop and iOS)

Opera

Other Components: Microsoft Excel 2003+ (optional)
Microsoft Word 2003+ (optional)
Microsoft Project 2003+ (optional)

*Note that SpiraTeam® can be loaded onto either Windows Server or workstation editions, provided that
the 1IS web-server is installed and that SQL Server is available as a database engine. However Windows
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workstation editions can only support a maximum of 5 concurrent user web sessions. In general unless
there are only going to be a couple of client machines hitting the server, we recommend using Windows
Server.

2.1. System Prerequisites

Assuming that you have already installed the appropriate version of Microsoft Windows onto your
computer (or that has been pre-installed for you), you need to then make sure that the various
prerequisites have been correctly added to your installation before trying to install SpiraTeam®. The
SpiraTeam® installer will check to ensure that the various prerequisites are in place, and will abort the
installation if any are missing, indicating to you what action needs to be taken.

We recommend that you install / configure the prerequisites in the following order:
Install the .NET Framework v4.0

Install SQL Server 2016, 2014, 2012, 2008

Install the latest version of Internet Explorer that your server OS allows
Ensure that IIS is installed

Ensure that ASP.NET 4.0 is enabled

vV Vv VY VY

2.1.1. Install the .NET Framework v4.0

On Windows Vista, Windows 7 and Windows 2008 Server installations, Microsoft .NET Framework v4.0 is
usually installed as part of the factory configuration, whereas on earlier operating systems, you might
need to manually add the .NET 4.0 components to the factory configuration. On Windows 8, 10 and
Server 2012, Microsoft .NET Framework 4.5 is installed which is fully compatible.

To see which version of the Microsoft .NET framework installed, open up Windows Explorer® and
navigate to C:\WINDOWS\Microsoft. NET\Framework and then the subfolders listed will indicate which
version(s) of the framework you have installed:

=l | ) Microsoft. MET

+ | ) assembly

=l [ Framewark
I w1.0.3705
vl 1.4322
) w2.0.50727
I w3.0

I %3.5
) w4.0.30319

NET Frameworks
1.0, 1.1,2.0, 3.0,

3.5 & 4.0 are installed

ru e s s

To install the .NET Framework, launch Internet Explorer and enter the URL.:
https://www.inflectra.com/CustomerArea. Once you have logged-in to the customer area, under the “My
Downloads” section there will be hyperlinks to download and install the appropriate version of the .NET
Framework (version 4.0 at time of writing). Click on the option to download and install the .NET
Framework, and follow the instructions provided. Once you have completed the install, verify that the
installation was successful by looking in the “Administrative Tools” folder as illustrated above. You also
need to make sure that .NET 4.0 has been installed if necessary.

Please make sure that the Full .NET 4.0 Framework is installed and not just the .NET 4.0 Client Profile.
You can check which is installed by going to Start > Control Panel > Programs & Features and then
looking for the different .NET 4.0 Framework components that are installed:
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https://www.inflectra.com/CustomerArea

_.?'- Microsoft MET Framework 4 Client Profile
--?‘-Micrusuﬂ MET Framework 4 Extended
B Microsoft .NET Framework 4 Multi-Targeting Pack

If you only see the “Microsoft .NET Framework 4 Client Profile” and not the “Microsoft .NET Framework 4
Extended”, then you need to install the additional .NET 4.0 components that are needed for server-based
applications such as SpiraTeam to run.

2.1.2. Install SQL Server 2014, 2012, 2008 or 2005

Install the appropriate version of the database software, following the instructions provided with the
installation. We recommend SQL Server Express Edition® for most users. This free version of SQL
Server will offer sufficient performance for most installations and can be easily downloaded from either
the customer area of our website (http://www.inflectra.com/CustomerArea) or directly from the Microsoft®
web-site at http://www.microsoft.com/express/sql.

2.1.3. Install Internet Explorer

Install the latest version of the Internet Explorer web browser that is supported by your version of
Windows. You are free to use Internet Explorer, Mozilla Firefox, Apple Safari, Google Chrome or Opera
with SpiraTeam®. Other browsers may work with SpiraTeam®, but they have not been exhaustively
tested for compatibility by Inflectra®.

2.1.4. Ensure that lIS is installed

On Windows Server OS installations, IIS is usually installed as part of the factory configuration, whereas
on Windows workstation OS installations, you typically need to manually add the components to the
factory configuration. The steps that you need to take to verify its installation are listed below for each
operating system family:

a) Windows XP or 2003 Server

To check if you have IIS installed, click Start > Control Panel > Administrative Tools. Under the
“Administrative Tools folder”, you should see an icon for “Internet Information Services”. If you don’t see
this icon, then it means that you need to add IIS to your computer:

@ Component Services

g Computer Management

B Data Sources (ODBC)

Event Viewer

Local Security Policy

Microsoft .NET Framework 1.1 Configuration

Microsoft .NET Framewark 1.1 Wizards . L
Derformance Indicates 1S is installed

Services

Internet Information Services

B & E BT F O

Server Extensions Administrator
¥ MetaEdit 2.2

To install 1IS, you need to click Start > Control Panel > Add or Remove Programs, then choose the option
to “Add / Remove Windows Components” as illustrated below:

© Copyright 2006-2016, Inflectra Corporation Page 4 of 126 This document contains Inflectra proprietary information



http://www.inflectra.com/CustomerArea
http://www.microsoft.com/express/sql

Check the box marked either “Internet Information Services (lIS)” or “Application Server”, and click
the “Next” button to install the missing Windows components. Once the installation has completed, IIS will
now be installed on your system. To verify that this is the case, type http://localhost into the address bar
of Internet Explorer on your computer. You should see a screen displaying the initial 1IS startup page:

Windows XP IS Default Page Windows 2003 Server IIS Default Page

If you don’t see this page, but instead see an IIS error page (e.g. Internal Server Error 500), please refer
to Appendix A — Troubleshooting IIS to fix your IS installation before following the rest of this installation
guide.

On Windows 2003 Server you may also need to go into the Web Service Extensions folder and make
sure that ASP.NET 4.0 is marked as ‘Allowed’. If you receive an HTTP 404 (Page Not Found) error when
running SpiraTeam® then it usually means that ASP.NET 4.0 is marked as Prohibited.

b) Windows 7, Vista or Windows Server 2008

To check if you have IIS installed, click Start > Control Panel > Administrative Tools. Under the
“Administrative Tools folder”, you should see an icon for “Internet Information Services (IIS) Manager”. If
you don'’t see this icon, then it means that you need to add IIS to your computer:
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ﬁh LN
12| Event Viewer

_g Group Palicy Management
tl Internet Information Services (115) 6.0 Manager

|'?5 Inkernat Infarmation Services (1151 Manager '—_’— Indicates that IS is installed

& i5CSI Initiator
i Local Security Policy
|3 Memary Diagnostics Tool

On Windows 7 or Vista, to install 1IS, you need to click Start > Control Panel > Programs and Features,
then choose the option to “Turn Windows features on or off”. This will bring up the list of features and
roles that can be configured on the server:

On Windows Server 2008, you need to click on Server Manager, then under the “Roles” heading,
choose the option to “Add Role” followed by selecting the new role “Web Server / [IS”. Then click “Next” to

bring up the role configuration screen:

Select the role services to install For Web Server (1151

Rale services:

o -~ !

/| Comman HTTP Features (Installzd)
Skatic Conkent (Installed)

Default Document (Installed)

Directory Browsing (Inskalled)

HTTP Errors {Installed)

HTTP Redirection (Installed)

pplication Developrment (Installed)

ASPL.MET (Installed)

MET Extensibility {Installed)

E ==

=&

OOE =

a5
a8

/| I3API Extensions (Installed)

/| ISAPT Filters (Installed)

[] server side Includes

Health and Diagnostics {Installed)

Security (Installed)

Petformance (Instaled)

anagement Toals {Installed)

115 Management Consale {Installed)

/| 115 Management Scripks and Tools (Installzd)

LI ¥ EYSveyeeysry b Sewniico (Toekalladt

Kz E<Em

More about role services

|»

Descripkion:

‘Web Server provides support For
HTML Web sites and optional suppork
for ASP.MET, ASP, and Web server
exkensions, You can use the Web
Server ko host an internal or external
‘web site or to provide an environment
for developers ko create Web-based
applications.




Make sure that the following features are enabled:

» Common HTTP Features
> Static Content
> Default Document
> HTTP Errors
> HTTP Redirection
> Application Development
> ASP.NET
D> .NET Extensibility
> ISAPI Extensions
D> ISAPI Filters
>» Management Tools
> IIS Management Console
> 1IS Management Service

To verify that this IIS is now installed, type http://localhost into the address bar of Internet Explorer on
your computer. You should see a screen displaying the initial IIS startup page:

c) Windows 8 or Windows Server 2012

To check if you have IS installed, click Start > Control Panel > Administrative Tools. Under the
“Administrative Tools folder”, you should see an icon for “Internet Information Services (1IS) Manager”. If
you don’t see this icon, then it means that you need to add IS to your computer:

[ Defragment and Optimize Drives TGS 22 118 PR Shortcut

&g Disk Cleanup TFS2M2 422 P Shortcut

{#l] Event Viewer FAn22 420 P Shortout

(7 Internet Information Services (15) Manager  7/25/2012 4:15 P Shortcut

fall, iSC3l Initistar Internet Information Services (15) Manager enables you to co
(2 Lacal Security Palicy control, and troubleshoot 15 and A3PMET,

E CDBC Data Sources (32-bit) T8 202 229 PR Shartcut

E QDBC Data Sources (B4-bit) T8 202 425 P Shartcut

On Windows 8, to install 1S, you need to click Start > Control Panel > Programs and Features, then
choose the option to “Turn Windows features on or off”. This will bring up the list of features and roles that
can be configured on the server:
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Turn Windows features on or off

To turn a feature on, select its check box, To turn a feature off, clear its
check box, & filled box means that only part of the feature is turned on,

] | ASP.MET 45
[w] L0 WWCF Services
O 1 Active Directory Lightweight Directory Services
[ Hyper-v
| Internet Explorer 10
= [ L0 Internet Information Services
O .y FTP Server
[w] 1 WWeb Managerment Tools
= [=] | Warld Wide Web Services
[=] 1 Application Development Features
[®] || Common HTTP Features
m [m] | Health and Diaannstic e

oK || Cancel |

On Windows Server 2012, you need to click on Server Manager, then under the “Roles” heading,
choose the option to “Add Role” followed by selecting the new role “Web Server / [IS”. Then click “Next” to
bring up the role configuration screen:

Roles Description
Velume Activation Services (Mot installzd) - Application Development provides
4 (W] Web Server (IIS) infrastructure for developing and
F] Web Server hosting Web applications, Use these
4 (W] Commen HTTP Features features to create Web content or
Default Document extend the functionality of IIS. These
Directory Browsing technologies typically provide a way
HTTP Errors to perform dynamic operations that
Static Content result in the creation of HTML
HTTP Redirection output, which IIS then sends to fulfill
WebDAVY Publishing (Mot installed) client requests,
[ [m] Health and Diagnostics
p (W] Performance
(W] Securi
=
NET Extensibility 3.5
NET Extensibility 4.5
Application Initialization (Not installed)
ASP (Mot installed)
ASP.NET 3.3 o
L4 >
| < Previous | | Next » | | Remaove | | Cancel

Make sure that the following features are enabled:

» Web Server (IIS)
> Web Server

» Common HTTP Features
> Default Document
> Directory Browsing
> HTTP Errors
> Static Content
> HTTP Redirection

> Application Development
> .NET Extensibility 3.5




© Copyright 2006-2016, Inflectra Corporation

.NET Extensibility 4.5
ASP.NET 3.5
ASP.NET 4.5
ISAPI Extensions
> ISAPI Filters
>» Management Tools
> IIS Management Console
D> 1IS Management Service
» .NET Framework 4.5 Features
> .NET Framework 4.5
> ASP.NET 4.5
> WCF Services
» HTTP Activation
» TCP Port Sharing

>
>
>
>

d) Windows 10

To check if you have IIS installed, click Start > Control Panel > Programs, then choose the option to “Turn
Windows features on or off”. This will bring up the list of features and roles that can be configured on the
server. You should see 'Internet Information Services' in the dialog box that pops up:

5l Windows Features O

Turn Windows features on or off

To turn a feature on, select its check box. To turn a feature off, clear its
check box, A filled box means that only part of the feature is turned on,

+ [m]

+

MET Framework 3.5 (includes MET 2.0 and 3.00
MET Framework 4.6 Advanced Services
Active Directory Lightweight Directory Services
Emnbedded Shell Launcher
Hyper-V
Internet Explorer 11

] FTP Server

+ @ | Web Management Tools

7 @ | World Wide Web Services

[
=

» WMEROOR

Internet Information Services Hostable Web Core

Isolated Llser Mnode

Cancel

pod

Make sure that the following features are enabled within the 'Inter

» Web Management Tools
> 1IS Management Console
> IS Management Service
» World Wide Web Services
> Application Development Features
» .NET Extensibility 3.5
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>
>
>
>

v

vYVYVYVYY

.NET Extensibility 4.6
ASP.NET 3.5
ASP.NET 4.6

ISAPI Extensions
ISAPI Filters

> Common HTTP Features

Default Document
Directory Browsing
HTTP Errors
HTTP Redirection
Static Content

In the same panel ('Turn Windows Features on or off') you also need to check that the following features
are enabled in the .NET Framework 4.6 Advanced Services' folder:

Windows Features O >
Turn Windows features on or off (7]
To turn a feature on, select its check box. To turn a feature off, clear its check
box. A filled box means that only part of the feature is turned on.

m] = .NET Framework 3.5 (includes .NET 2.0 and 3.0) ~
= MET Framewaork 4.6 Advanced Services
ASP.INET 4.6
= WCF Services
Message Queuing (M5MQ) Activation
Named Pipe Activation
TCP Activation
TCP Port Sharing
[l Active Directory Lightweight Directory Services
] Embedded Shell Launcher
[ ] HyperVv
Internet Explorer 11 v
| | Cancel

>
>

» .NET Framework 4.6 Advanced Services
> ASP.NET 4.6
> WCF Services

HTTP Activation
TCP Port Sharing

To verify that this IS is now installed, type http://localhost into the address bar of Internet Explorer on
your computer. You should see a screen displaying the initial IIS startup page:



http://localhost/

2.1.5. Ensure that ASP.NET is installed

Now that you have both IIS and .NET installed, you need to make sure that the Active Server Pages
(ASP.NET) components that allow IIS to access the .NET framework have been correctly configured. If
you installed .NET after IS then ASP.NET is typically configured for you, but if you installed IS
afterwards, then further manual steps may be necessary. The settings are different depending on which
version of Windows you are using:

a) Windows XP or 2003 Server

To verify that ASP.NET has been correctly configured, click on Start > Control Panel > Administrative
Tools > Internet Information Services to launch the IS administrative console:

T
"B

Internet Information Services

File Acton View Help

€+ AW EFRB 2 2 > =

% Internet Information Services Mame | Path
E‘Q SANDMAN.G"E' computer) @IISHEIp c: windows\helpliishelp
=0 Web Sites L@soripts C:\Inetpub'Scripts

:'ff'ult Veb Sit L@ _vti_bin C:\Program Files\Comman Files\Micr..,
#< Default SMTP Virtual Server | - brinters C\WINDOWS web \printers




Expand the name of the web-server (marked as local computer), expand the “Web Sites” folder, right-click
on “Default Web Site” and choose the “Properties” link. This will bring up the 1IS configuration dialog-box
with the ‘Virtual Directory’ tab highlighted. Then click on the ‘ASP.NET’ tab if it is listed:

SpiraTest Properties

HTTP Headers Custom Emors ASP.NET Virtual Directony Documents Directony Security
Virtual Directory Documerts Directary Security HTTP Headers Custom Emors ASP.NET
When connecting to this resource, the contert should come from:
(@) A directory located on this computer Migrosgft
() A share located on another computer nﬁt
() Aredirection to a URL .
Local Path: C:\Subversion“\Projects Inflectra’ Trank\F
[ Seript source access Log vists
Bead Index this resource o 3
[ Write ASP.NET version: j
[ Directory browsing Virtual path: |f"Sp||E|Test
Application Settings
File location: |C:'-.Subversmn"-.ijects"-.SpuaTeam"-.Trunk"-.Splm
Application name: SpiraTest
Starting poirt: <Default We..\SpiraTest . . File creation date: |5,-’23,-’2D1 01:29:55 PM
Execute Pemmissions:  Scripts only File last modified: |5/23f2|}1 01:29:55 FM
Application Protection:  Medium (Pooled) |
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If ASP.NET 4.0 is correctly configured you will see the ASP.NET tab, and it will list the ASP.NET version
as being ‘4.0.30319’ as illustrated above. If you don’t see this tab, you either don’t have ASP.NET
configured, or you have an earlier version of ASP.NET (v1.1 or v2.0) configured.

To configure ASP.NET 4.0 for an existing 1IS website, you need to open up Windows Explorer and
navigate to the folder containing the .NET Framework. So, for example, if you have .NET Framework v4.0
installed, you would navigate to C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319. Now, you need
to open up a Windows command prompt by clicking Start > Programs > Accessories > Command Prompt.
This will open up the command prompt window:

Now change the directory in the command window to the folder name in windows explorer (i.e. type

cd C:\WINDOWS\Microsoft.NET\Framework\v4.0.30319 where the version number matches the
version number of the framework you have installed). Once you have changed the directory to the
appropriate folder, type aspnet_regiis.exe —i to configure ASP.NET. You can now verify that ASP.NET
has been installed by checking the 1IS management console (as described above).

For 64-bit versions of Windows, please use C\WINDOWS\Microsoft NET\Framework64\v4.0.30319
b) Windows Vista, 7 or 2008 Server

Page 12 of 126 This document contains Inflectra proprietary information




To verify that ASP.NET has been correctly configured, click on Start > Control Panel > Administrative
Tools > Internet Information Services (1IS) Manager to launch the IIS administrative console:

You should see a section called “ASP.NET” occupying the top third of the 1IS screen. If not, then you
need to go back to section 2.1.3 and make sure that you chose the option to install ASP.NET when
installing IIS.

c) Windows 8, 10 or 2012 Server

To verify that ASP.NET has been correctly configured, click on Start > Control Panel > Administrative
Tools > Internet Information Services (11IS) Manager to launch the IIS administrative console:

You should see a section called “ASP.NET” occupying the top third of the 1IS screen. If not, then you
need to go back to section 2.1.3 and make sure that you chose the option to install ASP.NET when
installing 11S.

2.2. Installing the Software

Now that all the prerequisites have been correctly installed, you are now ready to install SpiraTeam® onto
your system. To perform the installation, you will need the installation package downloaded from the
Inflectra® website, the name of the organization that the software is licensed to, and the actual license key
code which will be available in the customer area of the Inflectra® website.
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To start the installation, double-click on the SpiraTeam® installation package (it will have a filename of the
form SpiraTestPlanTeam-vX.X._.X.X.msi), and the Windows Installer will display the following dialog
box:

If you are upgrading from an earlier version of SpiraTeam®, the dialog box will be similar except that it will
instead let you know that you are upgrading from an earlier version to the current one:

|§~ SpiraTeam Setup

Welcome to the SpiraTeam
Setup Wizard

The Setup Wizard will upgrade the wersion of SpiraTeam on
yaur computer ko w4,0,0,0, Click Mext to continue or Cancel
to exit the Setup Wizard,

inflectra”

= Back Cancel I

In this instance the installer will update the program files on your computer and migrate your data into the
new version seamlessly. If for any reason you don’t see the upgrade message and you have an existing
installation, don’t continue, but instead contact Inflectra® customer support first. This will ensure that
your existing data is not overwritten by a clean install.

In the case of an upgrade, the system will make a temporary backup of your database to the
C:\Users\[UserName]\AppData\Local\Inflectra folder, so you need to make sure you have at least twice
the disk space available on the C:\ drive as the size of your existing database. If you want to specify a
different temporary location, please set the TST_WORKING_FOLDER Windows® environment variable
to the location you wish to use instead.




In either case, click the “Next” button to start the installation wizard which will gather information from you
regarding how you want to setup the system, before actually installing the web-server files and database
components. The next page of the installation wizard will display a list of all the required pre-requisites
and whether the installer could find them or not:

If any of the prerequisites were not correctly installed, the installer will display a red cross icon next to the
missing component(s). If this happens, please refer to section 2.1 for installation of any prerequisites. If
for any reason you have the prerequisite installed but the installer was not able to find it (this can
occasionally happen on certain environments), click the “Ignore” button to proceed with the installation.

Once the prerequisites have been correctly installed, clicking “Next” will bring you to the next page in the
installation wizard:

The next screen in the installation wizard outlines the SpiraTeam® End User License Agreement (EULA).
Please read this carefully as it describes the legal contract between you — the user of the software — and

Inflectra® Corporation, the developer and publisher. Once you have read the agreement and understood

your rights and obligations, select the radio button marked “I accept the terms in the License Agreement”
and click the “Next” button.

The following screen will be displayed:
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You need to choose the product that you will be installing — SpiraTest®, SpiraPlan® or SpiraTeam®. This
is important because the license key for each product is different.

Once you have chosen the product, the following screen will be displayed:

You need to enter your full name, the organization that was issued the software license, and finally
the full hexadecimal license key that was provided with the software. Once you click “Next”, the installer
will verify that all three were entered, and that the license key matches the product being installed and
that it matches the organization name. The installer will warn you of any discrepancies, but will allow you
to proceed; however after installation, the system will not operate until a correct license key is entered.

If for any reason you are unable to get the provided license key to work, please contact Inflectra®
customer support immediately and they will resolve the issue.
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After clicking “Next”, you will be given the choice of installation to perform:

By default, the installer will install all of the SpiraTeam® features onto the target system, so we
recommend choosing “Complete Installation”, which will both install the complete system — application
and database. For advanced users who want to change the folder to which the system is installed (by
default itis Cz:\Program Files\SpiraTeam), change the name of the database created (by default it
will be SpiraTeam) or to prevent the installation of the optional web-services data integration modules,
you can choose the “Custom Installation” option, which allows you to change those settings prior to
installation.

The “Application Only” installation is useful when you need to move the application to a different server,
but want to leave the database installed on the same server. In this case you can use the “Application
Only” installation on the new server, and once the installation is completed, change the name of the
database pointed to in the “Web.Config” file to the existing database server.

This manual assumes that the “Complete Installation” option is chosen, in which case the following
screen is displayed:

This screen allows you to change the name of the web-site URL that will be user to access the system.
By default, users would need to type into their browsers: http://"server name”/SpiraTeam. Should you
want to have a different name — other than SpiraTeam — change the name in the Virtual Directory box,
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otherwise simply accept the default name and click “Next’. Note: The installer will check to make sure that
the name you have chosen is not already in use, and will warn you if it is.

Upon clicking “Next”, you will be taken the database connection screen:

You can connect to the SQL Server database using either Windows Authentication or SQL Server
Authentication, and the process is slightly different for each mode:

2.2.1. Windows Authentication

This is the easiest option when the application and database will be residing on the same server. In this
case, choose the “Windows Authentication” option and the Login/Password boxes will be disabled. In this
case, the installer will connect to the database using your current Windows login to create the application
database objects, and SpiraTeam® will connect to the database during normal operation using either the
ASPNET or NETWORK SERVICE Windows accounts (it depends on the version of the operating
system).

2.2.2. SQL Server Authentication

This is the easiest option when the application and databases will be residing on different servers across
the network. In this case, choose “SQL Server Authentication” and provide a SQL Server Login that has
Database Owner (DB-Owner) permissions — e.g. the built in System Administrator (SA) account. The
installer will use this DB-Owner account to create the database objects, and SpiraTeam® will use a
special login (called SpiraTeam by default) for normal application operations.

2.2.3. For Either Mode

In the “Server” box, you need to enter the name of the Microsoft SQL Server instance that is running on
your system; the installer will default it to the hostname of the server (which in many cases will be
correct). The easiest way to find out the database server name is to open up the SQL Server
Administrative console (typically by clicking Start > Programs > Microsoft SQL Server > Enterprise
Manager) and look for the name of the server.

For SQL Server 2005/2008 Express edition installations, the Server name is usually the name of your
computer followed by \SQLEXPRESS”, so for example, if your computer is called MyComputer, the
server name would be MyCompute\SQLEXPRESS. Omitting the second part (called the instance name)
would lead to a “host not found” error.
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You can also choose whether to install the sample projects or not — typically we recommend installing the
sample projects for evaluation installations and excluding them for production installs.

Once you have entered the various pieces of information, click “Next”. The installer will attempt to connect
to the database using the provided information, and it will display an error message if any of the
information is incorrect. Assuming the information is correct, the following screen will be displayed:

This page lets you customize the name of the database login, database name and database user that the
application will create. If you chose the “Custom Installation”, then the fields will be editable, otherwise
they will be read-only. Also if you chose “Windows Authentication” then the Database Login field will be
set to the built-in Windows account associated with ASP.NET for the specific operating system being
installed on (and cannot be changed). Once you have reviewed this page and made any changes, you
should click “Next” to proceed:

Click the “Install” button to actually begin the process of installing SpiraTeam® onto your system. If you
are installing SpiraTeam® onto a version of Windows that has the User Access Control (UAC) enabled,
then you will first be prompted to confirm that you want to install a new piece of software. Click the option
that confirms you want to proceed with the install:
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@ User Account Control

] Do you want to allow the following program to install software on this
«/ computer?

Program name:  d4fbzzcl.msi
Yerified publisher: Inflectra Corporation

Change when these notifications appear

Click the “Yes” button to confirm that you want to install the software package.

The installer will then display a progress bar that gradually fills as the installation proceeds:

Once the installation is complete, the following message will be displayed:

i-.\!“ SpiraTeam Setup B I

Completing the SpiraTeam
Setup Wizard

Click the Finish button to exit the Setup wWizard,

inflectra”

Cancel |

< Back

Click the “Finish” button to complete the installation.

Congratulations! You have successfully installed SpiraTeam® onto your system. If you type

http://localhost/SpiraTeam into your browser you should see the SpiraTeam® login page, as illustrated in
the SpiraTeam® User Manual. If for any reason you don’t see the login page, please refer to Appendix A
— Troubleshooting IIS or contact Inflectra® Technical Support using one of the methods described at our

website http://www.inflectra.com/Support.



http://localhost/SpiraTeam
http://www.inflectra.com/Support

2.3. Security Considerations

The Microsoft Internet Information Services (IIS) web-server and SQL Server database are powerful tools
to managing web-based applications. However it is important to make sure that they are correctly secured
to prevent unauthorized access to applications being hosted on them. This is a fast changing field and
beyond the scope of this guide to address, however we recommend reading the following article for
details on how to secure IIS:

http://www.iis.net/learn/manage/configuring-security

In addition to the steps outlined in this article, it is important to note that by default, all web pages served
by 1IS using the HTTP protocol are unencrypted, and as such, the usernames and passwords used by
SpiraTeam®to log into the application can be read by network sniffing tools. If you are using SpiraTeam®
purely within an intranet environment, this may not be an issue. However if you are externally hosting
SpiraTeam® onto a publicly accessible website, we recommend installing a Secure Sockets Layer (SSL)
encryption certificate, and restricting all web-traffic to the secure HTTPS protocol instead.
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3. System Administration

Now that you have successfully installed SpiraTeam®, this section of the guide outlines how to perform
the typical system-wide administrative tasks necessary for setting up projects in the system, managing
users and verifying the license information. To perform these tasks, you need to login to the system with a
username that has “System Administration” permissions. The special “administrator” username is created
by the installer for this very purpose. You should initially login to SpiraTeam® with the username
administrator, and the password PleaseChange. It is recommend that this password be changed as
soon as possible to something that is secure yet memorable by clicking on the “User Profile” link — see
the SpiraTeam® User Manual for more details.

Once you have logged in as the administrator, you need to click the “Administration” link which can be
found in the main SpiraTeam dropdown menu in the top-left of the screen:

This will display the Administration home page:

The Administration home page is divided into two main areas — the left hand navigation bar that contains
links to all the available administration options (grouped under headings) and the main pane that displays
the available settings for the selected option. By default, the “View/Edit Projects” administration screen
will be displayed in the main pane.

The options available to you in the left hand navigation bar will vary depending on your level of
administrative privileges. If you have the “system administration” privilege granted, then all the options will
be available, whereas if you are just a “project owner”, only those options relating to managing a specific
project will be available.

When you first install the system, the three main tasks you will need to perform as the system
administrator are creating/editing projects, creating/editing users and then adding the users as members
of the various projects. These tasks typically need to be performed before any other users can use the
system, since there will be no logins or projects available other than the sample ones provided during the
installation.
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Each of the individual administrative options is described in turn below:
3.1. Projects

3.1.1. View/Edit Projects

The following screen is displayed when you choose the “View/Edit Projects” link from the Administration
sidebar navigation:

This screen displays the list of projects in the system (both inactive and active) together with their project
group, date of creation and active status. Clicking on either the “Select” link in the right-hand column or
the name of the project will change the currently selected project to one clicked, and any project-specific
administration tasks will be applied to this project.

You can filter the list of projects by either choosing an active status, project group, or entering a portion of
the name or date into the appropriate text box. When you click the “Filter” button, the list of projects will
be filtered by the criteria you entered. You can clear the filter selection by clicking the “Clear Filters”
button. To sort the list of projects, just click on the appropriate arrow icon located in the header row of
each field (one each for ascending / descending) In addition, the list of projects is paginated into groups
of fifteen (15). You can step through the different pages by clicking the page numbers at the bottom of the
project list.

To permanently delete a project, you should click the “Delete” button to the right of the project details.
This is irreversible and will delete all the artifacts associated with the project. If you want to temporarily
delete a project, set its Active flag to ‘No’ instead. To make a copy of a project to reuse its test cases,
releases, test sets and requirements, click the “Copy” link to the right of the project. Note that this will not
make a copy of any historical information, test runs or incidents.

To add a new project to the system, click the “Add” button at the bottom of the project list, and a new
screen will be displayed that allows you to enter the new project information:
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You need to enter a name for the project (which cannot be the same as any already in use); select which
project group it belongs to and optionally enter a detailed description and/or web-site URL. You should
initially make sure that the project is marked as “Active”. In addition, you can choose to either use the
“default template” or to use an existing project as the template. Using an existing project as the template
will copy across the workflows, user membership, custom properties, document types, document folders,
data synchronization and other configuration settings that you want to reuse in the new project. Once you
are satisfied with the information, click the “Insert” button to actually create the new project.

In a similar way, to edit the details of an existing project, click the “Edit” button in the right hand column of
the project list box, and you will be taken to the following screen that allows you modify the project details:
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On this screen you can edit the name, description, project group, website URL and active status. Once
you have made the necessary changes, click the “Save” button to commit them. If you decide that you
want to ignore the changes, click the “Cancel” button and the changes will be discarded.

3.1.2. Edit Project Groups

The following screen is displayed when you choose the “Edit Project Groups” link from the Administration
sidebar navigation:

This screen displays the list of project groups in the system (both inactive and active) together with their
web site URL, date of creation and active status. Project Groups are used to relate projects that are in the
same department/division/organization or are for a common customer, client, etc. When projects are in
the same group, a user that is a member of the project group can see the special Project Group
Dashboard that displays key metrics from all the projects in the group combined. Also such users will
have observer-level access to the contained projects without needing to be explicitly added to each
project.
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You can filter the list of project groups by either choosing an active status, or entering a portion of the
name, web-site or date into the appropriate text box. When you click the “Filter” button, the list of project
groups will be filtered by the criteria you entered. You can clear the filter selection by clicking the “Clear
Filters” button. To sort the list of project groups, just click on the appropriate arrow icon located in the
header row of each field (one each for ascending / descending) In addition, the list of project groups is
paginated into groups of fifteen (15). You can step through the different pages by clicking the page
numbers at the bottom of the project list.

To permanently delete a project group, you should click the “Delete” button to the right of the project
group details. Any projects contained in the group will not be deleted, but instead just moved to the
default project group. There has to be at least one project group in the system at all times, so the project
group designated as the ‘default’ one will not be available for deletion.

To add a new project group to the system, click the “Add” button at the bottom of the project group list,
and a new screen will be displayed that allows you to enter the new project group information:

You need to enter a name for the project group and optionally enter a detailed description and/or web-site
URL. You should initially make sure that the project group is marked as “Active”. In addition, you can
choose to make this project group the default one (meaning that it cannot be deleted and projects get
added to it when their groups are deleted). Once you are satisfied with the information, click the “Insert”
button to actually create the new project group.

In a similar way, to edit the details of an existing project group, click the “Edit” button in the right hand
column of the project group list box, and you will be taken to the following screen that allows you modify
the project group details:

© Copyright 2006-2016, Inflectra Corporation Page 26 of 126 This document contains Inflectra proprietary information




On the top part of this screen you can edit the name, description, website URL, active status and default
status. Once you have made the necessary changes, click the “Save” button to commit them. If you
decide that you want to ignore the changes, click the “Cancel” button and the changes will be discarded.

In addition, the lower part of the screen allows you to view/edit the users that are members of the group
and also see which projects are in the group:

a) Group User Membership

This tab allows you to see which users are members of the group and which group role they have:

The two project group roles are “Executive” and “Group Owner”:

» Executive — This role allows the user to see the dashboard for this project group, which contains
all the key metrics for the contained projects displayed in an aggregated manner. Please see the
SpiraTeam User Manual for more details on this dashboard. In addition, the user is automatically
granted ‘observer’ permissions for all the projects in the group.
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» Group Owner — This role consists of all the permissions granted to the “Executive” role above,
but in additional allows the user to make changes to the Project Group itself in the Administration
section.

To change the role of an existing project group member, just change the role in the drop-down list and
click [Save]. To remove a member from the group, just select the appropriate checkboxes and click
[Delete]. Finally, to add a new user to the group, click on the [Add] button:

You now should narrow down the list of users by entering filter criteria and clicking [Filter]. Once you have
located the appropriate user(s), just select a group role for them from the drop-down list and click [Add] to
add them to the group in the specified role.

b) Group Project List

This tab allows you to see the list of projects that are contained within the current group. Clicking on the
name of the project will take you to the details page for that project:

3.1.3. Project History

This page displays a list, by default in chronological order, of changes made to items within the selected
project.
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At this time, only changes made to Requirements, Tasks, Incidents, Test Cases, Test Steps, Test Sets,
Releases, and Automation Hosts are recorded. Certain changes are to these artifacts are not recorded,
such as location changes (indenting, outdenting), and comment additions.

There are a handful of change types recorded and displayed here:

e Modified: The most common, this means that one or more fields in this artifact were changed.
Note that if a standard field and a custom field were changed at the same time, it will generate
two separate entries, one for the standard fields, one for the custom fields.

e Added: This means that this artifact was added, created in the system, either by using the New
menu option or by copying. Pasting an item that was cut will not result in an Added entry being
created.

¢ Rollback: This items means that the artifact was rolled back to a specific event in the history.
o Deleted: This entry is created when an artifact is deleted from the system.

¢ Undelete: This entry is created when an artifact was deleted and then undeleted, making it live in
the system again.

e Purged: This entry is created (and all other history items are removed) when a deleted artifact is
purged from the system. Purged items are removed from the database, and cannot be recovered.

Note: When upgrading from a version before v3.1, each individual field changed will be considered a
unique change, due to how previous versions recorded history. However, as soon as the application is
upgraded, simultaneous changes will be grouped together based on their last-update date.

This screen allows the administrator several options:

e Viewing Details: The detail screen for each change set can be viewed by clicking on the change
ID #. This will take you to the history details screen, described below.

e Revert. This button will roll back all items in the list that are checked. You must have at least one
row checked to revert. See the section on reverting below.
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e Purge All: This button will permanently purge all deleted items from the database. Once items are
purged, they cannot be restored.

3.1.4.1. History Details Screen
The history details screen displays information on the selected change set:

The History Details screen will show basic information as well as fields that were changed in this change
set. Shown here is the Change ID, the date and time that the change was made, the user that made the
change, the change type, the artifact affected, and the set of fields affected.

If a set of fields were affected (Standard or Custom), then the list of fields will be listed below. In the
example above, the change was a Modification, and 5 fields were changed. In other change types, no
fields will be displayed.

If the artifact is still available in the system, you can click the Artifact or click the ‘View ltem’ button in the
toolbar to view the item as it is currently. However, if the item has been deleted, a warning label will be
displayed (as above in the example screenshot), the View Item links will be disabled, and a new option,
“Purge” will appear on the toolbar.

3.1.4.2 Purging ltems

Items that have been deleted by any user still remain in the database, but do not affect statistics or
reports, and do not show up in reports and cannot be viewed. The artifacts are still in the database,
however, and can be restored by clicking on the Restore button in the toolbar.

Purging an individual item can only be done while viewing one of its history detail screens. Once an item
is purged, you will be taken back to the history list screen. All the previous history items for the artifact will
be removed, and replaced with a single “Purged” history item.

Items that are purged cannot be restored into the database, as unique identifiers will be wiped from the
database, so be sure that you are sure you want to purge an item before doing so.

You can purge all items in the project at once by clicking the “Purge All” button located on the History List
page. This will take some time depending on how many deleted items are in your database, and it is
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recommended that the database files be compressed in SQL Management Studio afterwards to free up
space and compress clustered indexes.

3.1.4.3 Reverting Items

Reverting an artifact will attempt to reset all fields back to the selected change set, reverting all changes
made after the selected change set as well. In certain cases, the artifact will not be able to be reverted —
cases like this could be caused by other items having been deleted or purged. (For example, if
Requirement #1 was linked to Release #4, and that Release does not exist anymore.) In cases like this,
no fields will be reverted and the artifact will remain unchanged.

Reverting an item will cause it to be undeleted if it has been deleted.

You can revert multiple items from the History List page — however, the only items that can be reverted
back are Deletes and Modifications. All other types will be ignored. When selecting multiple items, you
can select more than a single change set for a specific artifact, the artifact will be rolled back to the
earliest change set selected.

3.1.4. Project Associations

By default, all projects in SpiraTeam are completely self-contained. Artifacts in one project can only be
linked or associated with artifacts in the same project. However, for some customers, they need a way to
share artifacts between projects. This administration screen lets the project admin specify which other
projects can access artifacts in the current project:

PFOjECt Associations Library Information System

< Change Project

The following other projects are allowed to access artifacts in this project as part of their own data:

m X Remove

«  Project Name Project Group Name Artifact Types Operations

[J  sample Application One Internal Projects ] Requirement , £ Test Case, ¥ Task, |, Document & Edit

O Note: the other projects will only have read-only access to the artifacts in this project.

Note: When you share artifacts from the current project to another project, the permissions in the other
project will determine which users can see the items, so you need to make sure that is acceptable before
enabling the sharing.

To share artifacts with another project, click on the ‘Add’ button in the toolbar:

Select the name of the project you want to share with and choose which artifact(s) you want to share with
this project:
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When you click the ‘Add’ button, SpiraTeam will add the new project association to the list:

Project Associations Library Information System

2 Change Project

The following other projects are allowed to access artifacts in this project as part of their own data:

Successfully added the new project association. X
O VNEN X Remove
+  Project Name Project Group Name Artifact Types Operations
A . = . = .
O Sample Application One Internal Projects IJ Requirement ,&Test Case, 'DTask » = Document (# Edit
O Sample Application Two External Projects "B Requirement ,& Test Case ,E Incident [# Edit

© Note: the other projects will only have read-only access to the artifacts in this project.

You can change the project association (for example to change which artifacts are shared) by clicking on
the ‘Edit’ button to the right:




This updates the association list:

PI’OjECt Associations Library Information System

%> Change Project

The following other projects are allowed to access artifacts in this project as part of their own data:

Successfully updated the project association.

C VGEE % Remove

«  Project Name Project Group Name Artifact Types

e : S g =)
O Sample Application One Internal Projects ‘_j Regquirement ,g Test Case, ‘F_jTask » = Document
[ Sample Application Two External Projects ‘B Requ'\rement, Incident,'?__jTask

@ Note: the other projects will only have read-only access to the artifacts in this project.

To remove an association, simply select its checkbox and click ‘Remove’:

PI"OjECt Associations Library Information System

2 Change Project

The following other projects are allowed to access artifacts in this project as part of their own data:

The selected projects have been removed from the list.

CVGE % Remove

+  Project Name Project Group Name Artifact Types

[ sample Application One Internal Projects ‘B Requirement, aTest Case, ?__]Task . ?;." Document

@ Note: the other projects will only have read-only access to the artifacts in this project.

Operations
(# Edit

& Edit

Operations

[ Edit




3.1.5. Project Data Tools

This page contains several different data management tools that can be used to identify certain data
issues in the system and correct them. There are two main sections to this page — Data Caching and
Indentation Hierarchy:

a) Data Caching

In order to improve the performance of SpiraTeam®, certain types of project data are cached. If for any
reason you make changes to test cases, test runs or tasks in the system through the database, you may
need to update the cached values for test execution status and task progress that are displayed on the
requirements and releases pages. To refresh the execution status or task progress data, click on the
appropriate “Refresh” button illustrated above.

b) Indentation Hierarchy

The Requirement and Releases pages use an “Indent” system for managing the hierarchy of information.
This allows requirements and test cases to be nested under parent items and be rapidly searched and
filtered on. Sometimes if a move/copy operation is interrupted (due to a network outage, etc.) the
hierarchy may get corrupted. If so, you'll see a red Error message instead of the Green OK. If that
happens, just click on the appropriate “Correct” button and the system will correct the indent levels for
you.
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3.2. Users

3.2.1. View / Edit Users

The following screen is displayed when you choose the “View/Edit Users” link from the Administration
sidebar navigation:

This screen displays the list of users in the system (both inactive and active) together with their first name,
middle initial, last name, username (login), administrative permission status and active status.

You can filter the list of users by either choosing an administrative / active status, or entering a portion of
the first name, middle initial, last name or username into the appropriate text box. When you click the
“Filter” button, the list of users will be filtered by the criteria you entered. You can clear the filter selection
by clicking the “Clear Filters” button. To sort the list of users, just click on the appropriate arrow icon
located in the header row of each field (one each for ascending / descending). In addition, the list of users
is paginated into groups of fifteen (15). You can step through the different pages by clicking the page
numbers at the bottom of the user list.

To add a new user to the system, click the “Add” button at the bottom of the user list, and a new screen
will be displayed that allows you to enter the new user information:
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On this screen, you can enter information about the user, such as their name, email address, and
department. You can also create their password, password reset question and answer. If you want the
user to be able to subscribe to items in the system as RSS feeds, you should also make sure that the
“Enable RSS Feeds” checkbox is selected and a GUID token is displayed in the text-box underneath.

When creating a new user, you can also set their role for projects. A user can be assigned a role to
multiple projects at once, by checking the required checkboxes in the dropdown list of projects. The same
role will be applied across all projects.

Note: If you make a user a System Administrator, it will force that user to always have the ‘Project Owner’
role on all their assigned projects, regardless of the chosen role. If you disable this option, they will then
revert back to their true role.

In a similar way, to edit the details of an existing user, click the “Edit” hyperlink in the user list box, and
you will be taken to the following screen that allows you modify the user details:
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On this screen you can edit the first name, middle initial, last name, username, email address, system
administration status and active status. You can also change the user’s password (if the user is managed
by SpiraTeam) or LDAP information (if managed by an external LDAP directory server). In LDAP-
Managed mode you enter the fully Distinguished Name (DN) for that user in your corporate LDAP server
and provide no password. SpiraTeam® will then query your corporate LDAP server for the password
information, reducing the number of passwords that a user needs to remember. Please see the sections
on “Importing LDAP Users” and “LDAP Configuration” for more details.

Once you have made the necessary changes, click the “Save” button to commit them. If you decide that
you want to ignore the changes, click the “Cancel” button and the changes will be discarded.

At the top of the page you can also see information relating to the activity of the user on the system, such
as when they last logged in.

In addition, there are three tabs that allow you to add/remove the user from projects, update the data-
mapping used when synchronizing artifacts that are assigned or created by the current user, and, where
relevant, specify whether the user can access the linked TaraVault™ source code management service..

If you click on the “Project Membership” tab you will be shown a list of projects that the user is currently a
member of:
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You can change the role that the user has on the various projects, by choosing the appropriate role from
the drop-down list and then clicking [Save]. To remove the user from a project, select its checkbox and
then click [Delete]. To add a user to a new project, click on the [Add] button and then choose the project
and associated role from the list of projects on the screen that is displayed:

Hen ry J Cooper Add User Project Membership
€ Back To User Details

The user is NOT a member of the following projects.

Please select a role for the projects you want to add this user to, then click [Add]:

Add | Cancel
Project Name Web Site Creation Date Active D Project Role
Sample Application One Etp=www.tempuri.org B 1-Dec-2005 Yes PR2Z - Select Role - v
Sample Application Two 1-Dec-20035 Yes PR3 --- Select Role - v

Then click [Add] to add the selected project(s) to the user’s project membership.

To view/change the list of usernames that a user has in an external bug-tracking system, click on the
“Data Mapping” tab. This section is used by the SpiraTeam data-synchronization service to map incidents
from SpiraTeam to other bug-tracking systems

Please see the SpiraTeam External Bug-Tracking Integration Guide for more details on using the data-
mapping tab.
If you click on the TaraVault membership tab, you can choose whether or not the user has access the

linked TaraVault source code repository. This service is only available for hosted/cloud instances of
SpiraTeam, and more details can be found in section 3.11.4 of this guide.

3.2.1.1. Importing LDAP Users

If your organization already has an LDAP compatible user management system in place (e.g. Windows
Active Directory, Novell eDirectory, OpenLDAP, IBM Tivoli, etc.), then instead of having to manually enter
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users one by one into SpiraTeam®, you can simply import them from your LDAP Server. Before doing
this however, you need to first setup the LDAP configuration (see the section on LDAP Configuration
below.

Once you have setup your LDAP server configuration in SpiraTeam®, clicking on the “Import Users From
and LDAP Server” will bring up the following screen:

Import Users from LDAP Server

€ Back To User List
Using the current LDAP configuration, the following new users are available for import into SpiraTeam

Please mark the anes you'd like to import then click the [Import] button:

Y Filter | % Clear Filter Import | Cancel

Middle Initial Distil ished
« CommonName A ¥ Login AY First Name AV ‘I' e intal ) stName AW Email Address AW NIS inguishe
ame

This screen lists all the users available in the LDAP server that have not been already imported into
SpiraTeam®. The users are listed by name along with their login, email address and fully distinguished
LDAP name (DN). You can narrow down the list by entering partial name matches in any of the fields
displayed and clicking [Filter] and/or you can sort the results by clicking on the directional arrows in the
field headings.

Select the checkbox of any users you want to import and click “Import” to complete the operation. These
users can now login to SpiraTeam® and use their existing LDAP login and password information.
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3.2.2. Project Membership

The following screen is displayed when you choose the “Project Membership” link from the Administration
sidebar navigation:

This screen displays the name of the current project together with a list of all the users who are currently
members of the project along with their currently assigned project role. If you want to modify the
membership for a different project, click the “Change Project” button to be taken back to View/Edit
Projects screen where you can select a different project.

To modify the role of a user assigned to the project, change the role for that user’s entry in the drop-down
menu and click the “Update” button. To remove a user from the project, check the box to the left of the
user's name and click the “Delete” button. Note that this only removes them from the project, not the
entire system.

To add a user to the project, so that can access its information, click the “Add” button and you will be
taken to the following screen that lists all the users in the system that are not currently members of the
project:

Library Information System add project Membershin

€ Back To Project Membership | Change Project

The following users are NOT members of this project.
Please select a role for the users you want to add to the project and click [Add]:

Y Filter % ClearFilter 4 Add | X Cancel

FirstName A¥  MIAY Last Name A¥  User Name A¥  Department AY Organization A'Y IDAY Project Role

us
Donna w Harkness donnaharkness Software Engineering uUse --- Select Role --- hd
Martha Noble marthanoble Software Engineering usio ---Select Role --- e
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You now should narrow down the list of users by entering filter criteria and clicking [Filter]; you can also
sort the results to make viewing easier. Once you have located the appropriate user(s), just select a
project role for them from the drop-down list and click [Add] to add them to the project in the specified
role.

3.2.3. Active Sessions

Often an administrator of the system will want to know how many users are currently logged into the
system, especially on installations licensed by concurrent-user. Clicking on the ‘Active User Sessions’
administration option will display a list of all the users who currently have active sessions in the system:

Active User Sessions

You currently have 1 active user(s) in the system.

The following users currently have active sessions on this instance of SpiraTeam:
First Name Last Name User Name Session ID Interface Last Logon ID Operations

System Administrator administrator Igiyejh luwplazzwnihiacOn Web Application 5/20/2016 9:43:08 AM us1 End Session

Toend a user's session, please click on the appropriate 'End Session' link above.

Each user is displayed along with their user ID, whether they’re connected through the application or via a
third-party add-on, and the date they last logged-in. The administrator is able to forcibly end a user’s
session using the ‘End Session’ link to the right of their name. Clicking this link will result in that user
being logged out when they try and perform an operation in the system. Warning: You should make
sure that the user is not actively using the system to prevent any unsaved data being lost.

3.2.4. Pending Requests

If you have enabled the ability for users to register for new SpiraTeam accounts themselves (see section
3.9.6 — Security Settings), clicking on the “Pending Requests” administration option allows you to view a
list of all the outstanding requests for new user accounts:

View Pending User Requests

The following new user requests exist in the system. To approve a user click the 'Approve’ link, to deny a request click on the 'Delete’ link.

Y Filter = % Clear Filter

First Name A ¥ MIAY  LastName AY User Name A 'Y Email? AY User # AY  Active AY Operations

—Any - v us —Any - v

For each pending user request you can choose to either Approve or Deny the request:

> Approve — clicking this option will approve the user. They will get an email letting them know that
they have been approved and can now log into the system.

> Delete — clicking this option will delete the pending user request from the system.

3.2.5. View / Edit Roles
There are six (6) default project roles that a user may be assigned to a project with:

» Project Owner — the same rights as a Manager, but in addition can access the project
administration tools
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» Manager — can see all screens and add/edit all artifacts, but cannot access project administration
tools

>» Developer — can see all screens, but can only add/edit incidents, tasks and tests and change
requirement coverage

>» Tester — can see all screens, but can only add/edit incidents and execute tests. Note: cannot
delete incidents, only a Manager can do that.

» Observer — can see all screens, but cannot perform any write operations (insert / update / delete)

Incident User — can only view and edit incidents. This user cannot even see the project’s
requirements, tasks, test cases or releases.

Note: The System Administrator is automatically added to every project as a Project Owner, and can
never be removed as Project Owner, made inactive or made a different role on the project.

You can make changes to the permissions associated with each of these default roles, and also create as
many additional roles as you like. To customize the roles in your installation of SpiraTeam®, click on the
“View / Edit Roles” link in the Administration sidebar navigation:

View / Edit Roles

The following roles have been defined in the system:

4+ Add Role

Role Name Description Active 1D Operations

Can see all screens, create/modify all artifacts, and can access the project

Project Owner . . Yes RX1 @ View
administration tools
Can see all screens and create/modify all artifacts, but cannot access project = e
Manager . . ¥ proj Yes RX2 (# Edit
administration tools
Can see all screens, but can only create/modify incidents and tests and change —
Developer Y v g Yes RX3 (# Edit

requirement coverage

Can see all screens, but can only create/modify incidents and execute tests. Note: =
Tester v v Yes RX4 [# Edit
cannot delete existing incidents

Observer Can see all screens, but cannot perform any write operations (create / modify / delete) Yes RX5 [# Edit

Can enly create/modify/view incidents. This role cannot see a project’s requirements,
testcases or releases.

Incident User Yes RX6 (£ Edit

The screen lists all of the roles currently configured in the system (both active and inactive) together with
the name, description, and an active flag. You can create new roles by clicking the “Add” button which will
create a new default role entry in the list. You can edit the name, description and associated permissions
of a role by clicking on the appropriate “Edit” button. You can delete an existing role, by clicking the
“Delete” button. Note that you cannot delete any of the default roles, but can instead make them inactive.

Clicking on the edit button will take you to the following screen:
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On the top of the screen, you can edit the name, description, project admin, limited view and active flags:

>» Project Admin — this flag denotes whether this role has administration-level access to the project
(for example the project owner role has this set by default)

> Limited View — this flag denotes that the role has a restricted view of the project, with the user
only allowed to see the artifacts that they have either created or been assigned

> Active — This flag denotes if the role is active in the system

Underneath you can specify the various artifact-specific permissions for the role:




These permission options allow you to specify if a user can create, modify, delete or view each of the
artifacts in the system. If a user does not have view permissions for the artifact, then the corresponding
tab in the system will also be disabled. There are two kinds of Modify permission available:

» Modify All — this option specifies that the user can modify all the artifacts of this type in the
project (e.g. the user can edit all test cases)

>» Modify Owned - this option specifies that the user can modify only the artifacts in the project that
were either created or assigned to this user (e.g. the user can edit only the requirements they
created or have been assigned)

Note: The permission needed to execute a test case is the “Create + Test Run” permission since that
initiates the creation of a new test run.

In addition, there are some artifact-wide permissions that can be specified for each role:

Other Permissions

This role can perform the following operations throughout the system:

Artifact Type Add Edit Delete View
Document Folder = v

Comment L4 =

Source Code = L4 = v

This section lets you specify if the role allows users to add new documents to the project, edit existing
documents, delete documents, edit the document folders, and view/edit source code revisions.
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3.3. Custom Properties

SpiraTeam allows you to customize all of the artifacts in the system (requirements, test cases, incidents,
etc.) by adding user-defined custom properties in addition to the built-in fields. You can create a variety of
different types of custom properties. This section describes how you setup different custom lists and
custom properties in your projects.

Artifacts in SpiraTeam can have up to 30 different custom properties per artifact-type, per project. There
are different types of custom properties allowed:

Text: Normal or Rich-Text field.

Integer: Whole-Number entry.

Decimal: Fractional number entry (currency, etc.)
Boolean: Simple yes/no (on/off) checkbox.

Date: Date selector.

List: Custom List selector.

Multi-List: Custom List selector that allows multiple values.

User: List of assignable users.

Each custom property can have optional settings applied to it. Optional settings are as follows. (Note that
not all settings are allowed for all property types.)

Default: The default value when a new artifact is created.

Allow Empty: Whether or not an empty value is allowed.

Precision: (Decimal Only) How many decimal places is allowed (or the value is rounded to).
Minimum Value: The minimum value allowed.

Maximum Value: The maximum value allowed.

Minimum Length: The minimum length of the data required in the field.

Maximum Length: The maximum length of the data allowed in the field.

Rich Text: Whether or not the text field allows HTML or not.

Custom List: The defined Custom List for the field that users can select from.

Important: Note that setting ‘Allow Empty’ to No will override any workflow step definitions, and will
always require a value to be entered in, even if the workflow is configured to have the field disabled!
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3.3.1. Edit Custom Lists

If you are planning on having any list based custom properties in your project, then you first need to
create and populate the custom project lists that the user will be able to select from. These lists are stored
separately from the individual artifact types so that you can have one set of values (e.g. list of operating
systems under test) be reused by multiple artifact types.

The following screen is displayed when you choose the “Edit Custom Lists” link from the Administration
sidebar navigation:

Ed|t CUStom LiStS Library Information System

# Change Project

The following custom lists have been created in this project. To add a new custom list, please click on the "Add List" option, to remove a custom list click the
appropriate "Remove" button and to edit a custom list (including its values), click on the "Edit Values" button.

=+ Add List

List # List Name # Values Actions

[CL:1] Difficulty 3 (# Edit Values =~ % Remove
[CL:2] Classification 2 (# Edit Values =~ % Remove
[CL:3] Test Type 3 (# Edit Values =~ ¥ Remove
[CL:4] Operating System 7 (# Edit Values =~ ¥ Remove
[CL:5] Web Browser 4 (# Edit Values =~ X Remove
[CL:6] Step Type 2 (£ Edit Values =~ % Remove

The screen displays all the custom lists currently defined within the project, together the number of values
associated with each list. By default the screen will initially be empty so the first thing you need to do is
click “Add List” to create a new custom list:

After changing the name of the list, and specifying whether the values will be ordered by their name or the
order in which they were entered (called by ID), you can either click “Save” to commit the change, or click
the “Add Value” option to add some list values:
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This is the set of values that the user will select from the drop-down list when the custom property is
displayed. You can change the display to include:

e All Active — displays only custom list values that are active

o All But Deleted — displays all custom list values that are active or inactive but have not been
deleted

e All —displays all custom list values, including those that have been deleted

To add a new custom list value, click the “Add Value” button and a new row will be added to the list which
you can now edit. To edit an existing custom list value, change the name in the textbox and click “Save”.
To delete a custom list value, click on the “Delete” hyperlink. If you want to remove an item from the list
temporarily, you can set its Active dropdown list to ‘No’, if you want to remove an item permanently, just
click the ‘Delete’ button.

Note: Even if you delete a custom list value, there is an option to undelete by simply changing the display
selection to “All” and clicking the ‘Undelete’ hyperlink next to a deleted value.

To edit an existing custom list, you just need to click on the “Edit Values” button to display the custom list
name and list of associated values (which is the same screen as the one displayed for a new list). To
remove a custom list from the project, just click on the “Remove” button next to the custom list and the list
and all its associated values will be deleted from the project.
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3.3.2. Edit Custom Properties

This option is used to actually define the custom properties associated with each artifact type in the
project. The following screen is displayed when you choose the “Edit Custom Properties” link from the
Administration sidebar navigation:

Ed|t Custom Pl’OpertieS Library Information System

Z Change Project

The following custom properties are currently defined for the selected artifact type. To view the custom

properties for a different artifact type, please change the type in the dropdown list below.

You can add, edit or remote custom property definitions by clicking the appropriate link in the grid

below:

Artifact Type: | Requirement
Field# Property Name
1 URL
2 Difficulty
3 Classification
- Notes
5 Review Date
& Ranking
7 Decimal
8
9

The screen displays a list of all the possible custom properties for a particular artifact type for the current
project. Each artifact type (requirement, test case, etc.) can have up to thirty (30) custom properties of

various types.

Initially the screen will default to showing the existing custom properties for a project’'s Requirements; to
change the list to a different artifact type (e.g. Incidents), all you need to do is change the artifact type in
the drop-down-list. This will refresh the list to show the custom properties for that artifact type.

To edit an existing custom property definition or add a new definition, click the “Edit Definition” button for
a specific property, and the following dialog will be displayed:

Type

Text

List

List

Text

Date

Integer

Decimal

~

Legacy Name

TEXT_01

LIST_O01

LIST_02

TEXT_02

Actions

(& Edit Definition

(& Edit Definition

[ Edit Definition

[ Edit Definition

[ Edit Definition

(& Edit Definition

(& Edit Definition

<+ Add Definition

<+ Add Definition

R Remove

® Remove

¥ Remove

¥ Remove

¥ Remove

X Remove

R Remove




The fields visible will vary depending on the type of custom property you have selected, but every custom
property will need to have a Name and a Type. The Name is the caption that will be shown to the user
when viewing or editing the artifact. The type is the type of data the field allows. If the custom property is
either a List or Multi-List type, you will need to choose the associated Custom List that you previously
defined.

Under the Options tab will be available options that can be set for the custom property:

When finished, click the ‘Save’ button and you will be returned to the Custom Property list.

Important: When changing a custom property’s type or removing a custom property, the data is not
actually removed from the artifact. Therefore, if you change a custom property from a date type to a text
custom property, the field will display the old date value until it is changed by the user.

3.4. Incidents

In addition to being able to create custom properties and values for incidents (same as for all artifacts in
SpiraTeam®), you can also change the values populated in many of the standard fields used in the
incident tracker — types, statuses, priorities and severities. The process for changing each of these is
described below:
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3.4.1. Edit Types

The following screen is displayed when you choose the “Edit Types” link from the Incidents section of the
administration sidebar:

The screen displays a list of all the defined incident types for the current project. By default the screen will
be populated with the standard SpiraTeam® incident types. To edit an existing incident type, change the
name, associated workflow, issue check-box, risk check-box, set a default type and/or change the active
flag then click “Update”.

You can’t delete an existing incident type, but to prevent it appearing in any drop-down-lists, all you need
to do is change its active flag to “No” and click “Save”. To add a new incident type, click the “Add” button
and a new row will be added to the list which you can now edit.

The associated workflow drop-down list allows you to specify which workflow the incident type will follow.
This is a very powerful feature since it allows you to configure different workflows for different incident
types; i.e. a bug may follow a workflow geared to identification and resolution, whereas a risk may only
need a much simpler set of steps and actions.

The issue and risk check-boxes allow you to specify if the incident type is an issue or risk-type, which
means it is would be eligible for display in the issue or risk section of the project home page respectively.
The default radio button allows you to specify which incident type should be the default for newly created
incidents. This is the type that a new incident will be set to unless changed by the creator of the incident.
Note that you must have at least one active incident type, and you cannot set an inactive type as the
default.

3.4.2. Edit Statuses

The following screen is displayed when you choose the “Edit Statuses” link from the Incidents section of
the administration sidebar:

© Copyright 2006-2016, Inflectra Corporation Page 50 of 126 This document contains Inflectra proprietary information




The screen displays a list of all the defined incident statuses for the current project. By default the screen
will be populated with the standard SpiraTeam® incident statuses. To edit an existing incident status,
change the name, open check-box, set it as the default status and/or change the active flag then click
“Save”.

You can’t delete an existing incident status, but to prevent it appearing in any drop-down-lists, all you
need to do is change its active flag to “No” and click “Save”. To add a new incident status, click the “Add”
button and a new row will be added to the list which you can now edit.

The open check-box allow you to specify if the incident status should be considered open or not, which
means it is would be eligible for display in the various sections of the user's home page and the project
home page that list open incidents. The default radio button allows you to specify which incident status
should be the default for newly created incidents. This is the status that a new incident will be set to when
first created, and acts as the first step in the incident workflow. Note that you must have at least one
active incident status, and you cannot set an inactive status as the default.

3.4.3. Edit Priorities

The following screen is displayed when you choose the “Edit Priorities” link from the Incidents section of
the administration sidebar:
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The screen displays a list of all the defined incident priorities for the current project. By default the screen
will be populated with the standard SpiraTeam® incident priorities. To edit an existing incident priority,
change the name, color and/or change the active flag then click “Save”. Note that you can either enter the
hexadecimal RRGGBB code for the color or use the pop-up color picker.

You can’t delete an existing incident priority, but to prevent it appearing in any drop-down-lists, all you
need to do is change its active flag to “No” and click “Save”. To add a new incident priority, click the “Add”
button and a new row will be added to the list which you can now edit.

3.4.4. Edit Severities

The following screen is displayed when you choose the “Edit Severities” link from the Incidents section of
the administration sidebar:

The screen displays a list of all the defined incident severities for the current project. By default the
screen will be populated with the standard SpiraTeam® incident severities. To edit an existing incident
severity, change the name, color and/or change the active flag then click “Save”. Note that you can either
enter the hexadecimal RRGGBB code for the color or use the pop-up color picker.

You can’t delete an existing incident severity, but to prevent it appearing in any drop-down-lists, all you
need to do is change its active flag to “No” and click “Save”. To add a new incident severity, click the
“Add” button and a new row will be added to the list which you can now edit.

3.4.5. Incident Workflows

Clicking on the “Edit Workflows” link in the Administration sidebar navigation brings up the list of defined
incident workflows for the current project. A workflow is a predefined sequence of incident statuses linked
together by “workflow transitions” to enable a newly created incident to be reviewed, prioritized, assigned,
resolved and closed, as well as to handle exception cases such as the case of a duplicate or non-
reproducible incident. The workflow list screen for a sample project is illustrated below:
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To modify the name, default status, notify and/or active flags, change the values in the appropriate text-
box, radio-button, check-box or drop-down list and click the “Update” button. To add a new workflow, click
the “Add” button and a new workflow will be created with the standard SpiraTeam® steps and transitions.

You can have as many workflows as you like in a project, but only one can be marked as the default.
Each incident type is assigned to a workflow; this allows you to have different incident types follow
different paths from creation of closure. However when a new incident type is created, it will be initially
associated with the project’s default workflow. The steps and transitions that make up the default
workflow are illustrated in the diagram below:

The notify flag is used to tell SpiraTeam® whether that particular workflow should have email notifications
turned on or off. You define what transitions and which recipients should receive the emails in the
workflow transition editor (see below), but you can globally turn on/off notifications here as well. This is
useful if you find that the notifications are becoming an annoyance, or if the email server is unavailable for
a period of time.

Note: You can only assign an active workflow to an incident type, and similarly you cannot make a
workflow inactive that is currently linked to an incident type. This is important as all incident types need to
be linked to an active workflow at all times.
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3.4.5.1. Edit Workflow Details

Clicking on the “Steps” button of a workflow brings up the following screen that lists all the workflow steps
and workflow transitions that comprise the workflow:

This page lists in the left-most column all the various incident statuses defined for the project. The next
column lists all the possible transitions that can occur from that status. In addition, with each transition is
listed the name of the resulting destination status that the transition leads to. E.g. from the assigned
status, depending on your role (see later) you can move the incident to either duplicate, resolves or not-
reproducible depending on which transition the user takes.

Clicking on the name of a step or transition takes you to the appropriate details page (see below) where
you can set the properties of the step or transition respectively. To delete an existing transition, click the
“x” button after the transition name, and to add a new transition, click the “Add Transition” button in the
Operations column.
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3.4.5.2. Edit Workflow Transition

When you click on the transition name link from the previous screen, you are taken to the workflow
transition details screen:

The top part of the screen is the “workflow browser” which illustrates how the transition relates to the
workflow as a whole. It displays the current transition in the middle, with the originating and destination
steps listed to either side. Clicking on either incident status name will take you to the appropriate workflow
step details page. This allows you to click through the whole workflow from start to finish without having to
return to the workflow details page.

This part of the screen lets you change the name of the transition and specify the subject line of any email
notifications sent as part of this transition. To view the list of special tokens that can be used in the email
subject, click on the “Display Email Subject Special Tokens” hyperlink:
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If a digital signature from the user is required to authorize and record the transition, set the toggle to yes

for “Require Electronic Signature”.
Each transition has a series of conditions which need to be satisfied for a user to actually execute the
transition (i.e. move the incident from the originating status to the destination status):

Each transition also has a set of notification rules that allow you to specify who should get an email
notification if the transition is executed.




Both the conditions and notifications allow you to set three types of user role:

> The detector of the incident can be allowed to execute the transition, and/or be notified when the
transition occurs. For example, when an incident is marked as Resolved, the detector should be
the only one who'’s allowed to move it to Closed. Similarly when an incident is moved from
Assigned to Resolved, the detector should probably be notified so that he knows to log in and
verify that it has been resolved satisfactorily.

» The owner of the incident can be allowed to execute the transition, and/or be notified when the
transition occurs. For example, when an incident is marked as Assigned, the assigned owner
should be the only one who's allowed to move it to Resolved. Similarly when an incident is moved
from Open to Assigned, the owner should probably be notified so that he knows to log in and
begin resolving the incident.

>» A user with a specified role can be allowed to execute the transition, and/or be notified when the
transition occurs regardless of whether they are the detector or owner. For example a user with
role “Manager” might want the power to close all incidents regardless of ownership status, and
might also want to be notified when any incident is marked as Not-Reproducible.

You can set any of these conditions by changing the drop-down list and/or check-boxes and clicking
the appropriate “Update” button.

3.4.5.3. Edit Workflow Step

When you click on the incident status name link from either of the previous screens, you are taken to the
workflow step details screen:
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The top part of the screen is the “workflow browser” which illustrates how the step relates to the workflow
as a whole. It displays the current incident status in the middle, with the possible originating and
destination transitions listed to either side. Clicking on either workflow transition name will take you to the
appropriate workflow transition details page. This allows you to click through the whole workflow from
start to finish without having to return to the workflow details page.

This page allows you to define the behavior of the various incident fields (i.e. those that are a standard
part of SpiraTeam® such as Priority):

This page also allows you to define the behavior of the various incident custom properties for this
particular step in the workflow:




You can set each of the fields/custom properties as being:
>» Hidden — The field / custom property will not be displayed when the incident is in this status
> Disabled — The field / custom property will be displayed, but will be greyed-out and read-only
>» Required — The field / custom property will be required when the incident is in this status

Note that you cannot set a field/property as being required and either disabled or hidden since this would
prevent a user from ever updating the incident. For example, when an incident is in the New status, you
might make the owner field hidden (since a detector shouldn’t need to know who will ultimately own it),
when it gets to the Open status, you might make the field active, and when it gets to the Assigned status,
you might make it active and required. This allows you to tailor the information gathered to the
appropriate place in the workflow.

To actually make these changes, all you need to do is select the appropriate checkboxes in the list of
fields and custom properties and click the corresponding “Update” button.
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3.5. Requirements

This section contains administrative options that are specific to the requirements functionality in the
system.

3.5.1. Edit Components

SpiraTeam lets you define a list of Components for each project. These components represent the main
functional areas of the system and requirements can be associated with each of the defined components.

This page lets you display the list of components based on three predefined filters:

o All Active — This displays only the components that are listed as Active = Yes. Only active
components will be displayed inside the main application.

o All But Deleted — This displays all the components (active and inactive) except those that have
been deleted.

e All - This displays all the components (active, inactive, and deleted).

From this page you can click on the ‘Add Component’ option to add a new component in the list:
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After entering the name of the new component and choosing its Active status, click on ‘Save’ to commit
the new item. To edit an existing component, edit its name and Active status and click ‘Save’. Finally to
delete a component, click the ‘Delete’ option next to its name. Once deleted, an item can be undeleted by
changing the display to ‘All' and then clicking ‘Undelete’.

3.5.2. Requirement Workflows

Clicking on the “Edit Workflows” link under the Requirements heading, brings up the list of defined
requirement workflows for the current project. A workflow is a predefined sequence of requirement
statuses linked together by “workflow transitions” to enable a newly created requirement to be reviewed,
prioritized, assigned, developed and tested, as well as to handle exception cases such as the case of a
rejected or obsolete requirement. The workflow list screen for the sample project is illustrated below:

The screen displays a list of all the standard requirement types in the system. The associated workflow
drop-down list allows you to specify which workflow the requirement type will follow. This is a very
powerful feature since it allows you to configure different workflows for different requirement types; i.e. a
User Story may follow a simpler review process than a Feature or Use Case requirement.

You can have as many workflows as you like in a project, but only one can be marked as the default.
Each requirement type must be assigned to a workflow. To modify the name, default flag, and/or active
flag of an existing workflow, change the values in the appropriate text-box, radio-button, or drop-down list
and click the “Save” button. To add a new workflow, click the ‘Add Workflow’ link and a new workflow will
be created with the standard SpiraTeam® steps and transitions.

Note: You can only assign an active workflow to a requirement type, and similarly you cannot make a
workflow inactive that is currently linked to a requirement type. This is important as all requirement types
need to be linked to an active workflow at all times.
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3.5.2.1. Edit Workflow Details

Clicking on the ‘Steps’ button of a workflow brings up the following screen that lists all the workflow steps
and workflow transitions that comprise the workflow:

This page lists in the left-most column all the various requirement statuses defined in the system. The
next column lists all the possible transitions that can occur from that status. In addition, with each
transition is listed the name of the resulting destination status that the transition leads to. E.g. from the
Requested status, depending on your role (see later) the user can move the requirement to either
Accepted or Under Review, depending on which transition the user takes.

Clicking on the name of a step or transition takes you to the appropriate details page (see below) where
you can set the properties of the step or transition respectively. To delete an existing transition, click the
‘x button after the transition name, and to add a new transition, click the ‘Add Transition’ button in the
Operations column.

3.5.2.2. Edit Workflow Transition

When you click on the transition name link from the previous screen, you are taken to the workflow
transition details screen:
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The top part of the screen is the “workflow browser” which illustrates how the transition relates to the
workflow as a whole. It displays the current transition in the middle, with the originating and destination
steps listed to either side. Clicking on either requirement status name will take you to the appropriate
workflow step details page. This allows you to click through the whole workflow from start to finish without
having to return to the workflow details page.

This part of the screen lets you change the name of the transition. If a digital signature from the user is
required to authorize and record the transition, set the toggle to yes for “Require Electronic Signature”.

In addition, each transition has a series of conditions which need to be satisfied for a user to actually
execute the transition (i.e. move the requirement from the originating status to the destination status):

The conditions section allows you to set three types of user role:

» The author of the requirement can be allowed to execute the transition. For example, when a
requirement is marked as Completed, the author might be allowed to move it to Obsolete when
it's no longer applicable.
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» The owner of the requirement can be allowed to execute the transition. For example, when a
requirement is marked as Under Review, the assigned owner should be the only one who's
allowed to move it to Accepted.

>» A user with a specified role can be allowed to execute the transition regardless of whether they
are the author or owner. For example a user with role “Manager” might want the power to close
all requirements regardless of ownership status.

You can set any of these conditions by changing the drop-down list and/or check-boxes and clicking
the appropriate “Save” button.

3.5.2.3. Edit Workflow Step

When you click on the requirement status name link from either of the previous screens, you are taken to
the workflow step details screen:

The top part of the screen is the “workflow browser” which illustrates how the step relates to the workflow
as a whole. It displays the current requirement status in the middle, with the possible originating and
destination transitions listed to either side. Clicking on either workflow transition name will take you to the
appropriate workflow transition details page. This allows you to click through the whole workflow from
start to finish without having to return to the workflow details page.

This page allows you to define the behavior of the various requirement fields (i.e. those that are a
standard part of SpiraTeam® such as Importance):
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This page also allows you to define the behavior of the various requirement custom properties for this
particular step in the workflow:

You can set each of the fields/custom properties as being:
> Hidden — The field / custom property will not be displayed when the requirement is in this status
> Disabled — The field / custom property will be displayed, but will be greyed-out and read-only
» Required — The field / custom property will be required when the requirement is in this status

Note that you cannot set a field/property as being required and either disabled or hidden since this would
prevent a user from ever updating the requirement. For example, when a requirement is in the Requested
status, you might make the owner field hidden (since the author shouldn’t need to know who will
ultimately own it), when it gets to the Accepted status, you might make the field enabled, and when it gets
to the In Progress status, you might make it enabled and required. This allows you to tailor the
information gathered to the appropriate place in the workflow.

© Copyright 2006-2016, Inflectra Corporation Page 65 of 126 This document contains Inflectra proprietary information




To actually make these changes, all you need to do is select the appropriate checkboxes in the list of
fields and custom properties and click the corresponding “Save” button.




3.6. Planning
The Planning section is only available for installations of SpiraPlan® and SpiraTeam®, not SpiraTest®
and lets you configure functionality related to project estimation and planning.

3.6.1. Planning Options
The Planning Options page lets you configure the schedule and calendar options for the various project
estimation and planning modules. The settings are specific to each project:

This page allows you to make changes to the following settings:

General

>» Work Hours Per Day - this setting allow you to specify how many work hours should be used
when converting an effort calculation from hours to calendar days. For example a 12 hour task




will occupy two days if you set the working hours per day to 6 hours, whereas the same task will
occupy 1 %2 days only if you set the working hours per day to 8 hours.

>» Work Days Per Week — this setting allows you to specify how many days in the week are
typically worked on the project. By default the system assumes a 5-day (Mon-Fri) working week,
but if your organization works Saturdays (for example), you may want to switch to a 6-day
working week. If you want to use partial days, then just round up to the nearest day and add non-
working hours (see below) to compensate.

» Non-Working Hours Per Month — this setting allows to specify how many non-working hours
typically need to be accounted for. This is useful if you want to have a working week that contains
a fractional number of days or if you have recurring activities that need to be removed from each
month. Note that if you have specific holidays, vacation days that need to be accounted for, it is
better to use the Release/lteration non-working time feature instead.

> Effort Calculations — When calculating how much effort has been scheduled in a release or
iteration, the system will aggregate the individual effort values (both estimated and actual) for all
the task, incident and test cases artifacts associated with the release/iteration. This setting allows
you to specify if you want only task, incident, or test case effort values to be included in the
release/iteration total. This is useful if your project management methodology requires that
incident or test case effort values be excluded from the total.

Requirements

> Default Estimate — Normally when you create a new Requirement in the system it will be given
an empty initial estimate (in points). However if many requirements are typically a standard size,
then as a time-saver, the system will let you specify a default estimate value that will be used
when a new requirement is created.

» Point Effort — When requirements are added to the Planning Board or Iteration planning screen,
they will have an initial effort (in hours) that is used until tasks are added (see Auto-Create Tasks
option). This field contains the standard conversion factor used to convert points into hours based
on the current team velocity (how much time it takes on average to accomplish one story point).
As the project progresses, the team velocity will change, so you can click on the [Suggest] button
to have the system calculate how many hours each existing story point has taken to implement in
the project and provide that as a recommendation:

» Auto-Create Tasks — When you change the status of a Requirement in the system to “In-
Progress” the system will automatically add a default Task to that requirement if no tasks already
exist. This is a useful shortcut that makes planning with requirements easier in the case when the
requirements are of a size where they don’t need to be formally decomposed into multiple
developer tasks. However if you don’t want the system to automatically create tasks in, you can
deselect the option for the current project and it will turn off the feature.
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>» Auto-Planned — When this option is enabled, if you assign a release/iteration to a requirement,
and the requirement is not already in the ‘Planned’ status, the system will automatically switch the
status of the requirement to ‘Planned’.

>» Use Task Status — When this option is enabled, if you add any tasks to a requirement, the status
of the requirement will be automatically governed by the aggregate status of the associated tasks.

>» Use Test Status - When this option is enabled, if you associate any test cases to a requirement,
the status of the requirement will be automatically switched from ‘Developed’ to ‘Tested’ when all
the associated test cases are passed.

Task & Incidents

> Default Effort — Normally when you create a new Task in the system it will be given an empty
initial estimated effort. However if many tasks are typically a standard size, then as a time-saver,
the system will let you specify a default estimated effort that will be used when a new task is
created.

» Time Tracking — SpiraTeam® has an integrated time tracking system that allows the easy entry
of the hours spent on all assigned incidents and tasks in one place (see the SpiraTeam User
Manual for more details on this feature). This setting allows administrators to specify if they want
the integrated time tracking features enabled for both incidents or tasks (or neither).

3.6.2. Release Workflows

Clicking on the “Release Workflows” link under the Planning heading, brings up the list of defined release
workflows for the current project. A workflow is a predefined sequence of release statuses linked together
by “workflow transitions” to enable a newly created release to be reviewed, prioritized, assigned,
developed and tested, as well as to handle exception cases such as the case of a cancelled or deferred
release. The workflow list screen for the sample project is illustrated below:

The screen displays a list of all the standard release types in the system. The associated workflow drop-
down list allows you to specify which workflow the release type will follow. This is a very powerful feature
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since it allows you to configure different workflows for different release types; i.e. a Major release may
follow a different process than an iteration.

You can have as many workflows as you like in a project, but only one can be marked as the default.
Each release type must be assigned to a workflow. To modify the name, default flag, and/or active flag of
an existing workflow, change the values in the appropriate text-box, radio-button, or drop-down list and
click the “Save” button. To add a new workflow, click the ‘Add Workflow’ link and a new workflow will be
created with the standard SpiraTeam® steps and transitions.

Note: You can only assign an active workflow to a release type, and similarly you cannot make a workflow
inactive that is currently linked to a release type. This is important as all release types need to be linked to
an active workflow at all times.

3.6.2.1. Edit Workflow Details

Clicking on the ‘Steps’ hyperlink of a workflow brings up the following screen that lists all the workflow
steps and workflow transitions that comprise the workflow:

This page lists in the left-most column all the various release statuses defined in the system. The next
column lists all the possible transitions that can occur from that status. In addition, with each transition is
listed the name of the resulting destination status that the transition leads to. E.g. from the Planned
status, depending on your role (see later) the user can move the release to either Cancelled, Deferred, or
In Progress, depending on which transition the user takes.

Clicking on the name of a step or transition takes you to the appropriate details page (see below) where
you can set the properties of the step or transition respectively. To delete an existing transition, click the
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‘x button after the transition name, and to add a new transition, click the ‘Add Transition’ button in the
Operations column.

3.6.2.2. Edit Workflow Transition
When you click on the transition name link from the previous screen, you are taken to the workflow
transition details screen:

The top part of the screen is the “workflow browser” which illustrates how the transition relates to the
workflow as a whole. It displays the current transition in the middle, with the originating and destination
steps listed to either side. Clicking on either task status name will take you to the appropriate workflow
step details page. This allows you to click through the whole workflow from start to finish without having to

return to the workflow details page.

This part of the screen lets you change the name of the transition. If a digital signature from the user is
required to authorize and record the transition, set the toggle to yes for “Require Electronic Signature”.

In addition, each transition has a series of conditions which need to be satisfied for a user to actually
execute the transition (i.e. move the release from the originating status to the destination status):
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The conditions section allows you to set three types of user role:

» The author of the release can be allowed to execute the transition. For example, when a release
is marked as Completed, the author might be allowed to move it to In Progress if there is still work
remaining.

» The owner of the release can be allowed to execute the transition. For example, when a release
is marked as In Progress, the assigned owner should be the only one who'’s allowed to move it to
Competed.

» A user with a specified role can be allowed to execute the transition regardless of whether they
are the author or owner. For example a user with role “Manager” might want the power to defer all
releases regardless of ownership status.

You can set any of these conditions by changing the drop-down list and/or check-boxes and clicking
the appropriate “Save” button.

3.6.2.3. Edit Workflow Step

When you click on the release status name link from either of the previous screens, you are taken to the
workflow step details screen:

The top part of the screen is the “workflow browser” which illustrates how the step relates to the workflow
as a whole. It displays the current release status in the middle, with the possible originating and
destination transitions listed to either side. Clicking on either workflow transition name will take you to the
appropriate workflow transition details page. This allows you to click through the whole workflow from
start to finish without having to return to the workflow details page.

This page allows you to define the behavior of the various release fields (i.e. those that are a standard
part of SpiraTeam® such as Priority):
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This page also allows you to define the behavior of the various release custom properties for this
particular step in the workflow:

You can set each of the fields/custom properties as being:
» Hidden — The field / custom property will not be displayed when the release is in this status
> Disabled — The field / custom property will be displayed, but will be greyed-out and read-only
» Required — The field / custom property will be required when the release is in this status

Note that you cannot set a field/property as being required and either disabled or hidden since this would
prevent a user from ever updating the release. For example, when a release is in the Planned status, you
might make the owner field hidden (since the author shouldn’t need to know who will ultimately own it),
when it gets to the In Progress status, you might make the field enabled and required, and when it gets to
the Completed status, you might make it disabled. This allows you to tailor the information gathered to the
appropriate place in the workflow.

To actually make these changes, all you need to do is select the appropriate checkboxes in the list of
fields and custom properties and click the corresponding “Save” button.

3.6.3. Task Workflows

Clicking on the “Task Workflows” link under the Planning heading, brings up the list of defined task
workflows for the current project. A workflow is a predefined sequence of task statuses linked together by
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“workflow transitions” to enable a newly created task to be reviewed, prioritized, assigned, developed and
tested, as well as to handle exception cases such as the case of a blocked or deferred task. The workflow
list screen for the sample project is illustrated below:

The screen displays a list of all the standard task types in the system. The associated workflow drop-
down list allows you to specify which workflow the task type will follow. This is a very powerful feature
since it allows you to configure different workflows for different task types; i.e. a Development task may
follow a different process than an Infrastructure or Management task.

You can have as many workflows as you like in a project, but only one can be marked as the default.
Each task type must be assigned to a workflow. To modify the name, default flag, and/or active flag of an
existing workflow, change the values in the appropriate text-box, radio-button, or drop-down list and click
the “Save” button. To add a new workflow, click the ‘Add Workflow’ link and a new workflow will be
created with the standard SpiraTeam® steps and transitions.

Note: You can only assign an active workflow to a task type, and similarly you cannot make a workflow
inactive that is currently linked to a task type. This is important as all task types need to be linked to an
active workflow at all times.
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3.6.3.1. Edit Workflow Details

Clicking on the ‘Steps’ hyperlink of a workflow brings up the following screen that lists all the workflow
steps and workflow transitions that comprise the workflow:

This page lists in the left-most column all the various task statuses defined in the system. The next
column lists all the possible transitions that can occur from that status. In addition, with each transition is
listed the name of the resulting destination status that the transition leads to. E.g. from the Not Started
status, depending on your role (see later) the user can move the task to either Deferred or In Progress,
depending on which transition the user takes.

Clicking on the name of a step or transition takes you to the appropriate details page (see below) where
you can set the properties of the step or transition respectively. To delete an existing transition, click the
‘x button after the transition name, and to add a new transition, click the ‘Add Transition’ button in the
Operations column.

3.6.3.2. Edit Workflow Transition

When you click on the transition name link from the previous screen, you are taken to the workflow
transition details screen:
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The top part of the screen is the “workflow browser” which illustrates how the transition relates to the
workflow as a whole. It displays the current transition in the middle, with the originating and destination
steps listed to either side. Clicking on either task status name will take you to the appropriate workflow
step details page. This allows you to click through the whole workflow from start to finish without having to
return to the workflow details page.

This part of the screen lets you change the name of the transition. If a digital signature from the user is
required to authorize and record the transition, set the toggle to yes for “Require Electronic Signature”.

In addition, each transition has a series of conditions which need to be satisfied for a user to actually
execute the transition (i.e. move the task from the originating status to the destination status):

The conditions section allows you to set three types of user role:

» The author of the task can be allowed to execute the transition. For example, when a task is
marked as Completed, the author might be allowed to move it to In Progress if there is still work
remaining.
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» The owner of the task can be allowed to execute the transition. For example, when a task is
marked as In Progress, the assigned owner should be the only one who’s allowed to move it to
Competed.

>» A user with a specified role can be allowed to execute the transition regardless of whether they
are the author or owner. For example a user with role “Manager” might want the power to defer all
tasks regardless of ownership status.

You can set any of these conditions by changing the drop-down list and/or check-boxes and clicking
the appropriate “Save” button.

3.6.3.3. Edit Workflow Step

When you click on the task status name link from either of the previous screens, you are taken to the
workflow step details screen:

The top part of the screen is the “workflow browser” which illustrates how the step relates to the workflow
as a whole. It displays the current task status in the middle, with the possible originating and destination
transitions listed to either side. Clicking on either workflow transition name will take you to the appropriate
workflow transition details page. This allows you to click through the whole workflow from start to finish
without having to return to the workflow details page.

This page allows you to define the behavior of the various task fields (i.e. those that are a standard part of
SpiraTeam® such as Priority):
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This page also allows you to define the behavior of the various task custom properties for this particular
step in the workflow:

You can set each of the fields/custom properties as being:
> Hidden — The field / custom property will not be displayed when the task is in this status
> Disabled — The field / custom property will be displayed, but will be greyed-out and read-only
» Required — The field / custom property will be required when the task is in this status

Note that you cannot set a field/property as being required and either disabled or hidden since this would
prevent a user from ever updating the task. For example, when a task is in the Not Started status, you
might make the owner field hidden (since the author shouldn’t need to know who will ultimately own it),
when it gets to the In Progress status, you might make the field enabled and required, and when it gets to
the Completed status, you might make it disabled. This allows you to tailor the information gathered to the
appropriate place in the workflow.
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To actually make these changes, all you need to do is select the appropriate checkboxes in the list of
fields and custom properties and click the corresponding “Save” button.

3.7. Testing
This section contains administrative options that are specific to the testing functionality in the system.

3.7.1. Test Case Workflows

Clicking on the “Test Case Workflows” link under the Testing heading, brings up the list of defined test
case workflows for the current project. A workflow is a predefined sequence of test cases statuses linked
together by “workflow transitions” to enable a newly created test case to be reviewed, prioritized,
assigned, and tested, as well as to handle exception cases such as the case of a rejected or obsolete test
case. The workflow list screen for the sample project is illustrated below:

The screen displays a list of all the standard test case types in the system. The associated workflow drop-
down list allows you to specify which workflow the test case type will follow. This is a very powerful
feature since it allows you to configure different workflows for different test case types; i.e. a unit test may
follow a different process than a regression test.
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You can have as many workflows as you like in a project, but only one can be marked as the default.
Each test case type must be assigned to a workflow. To modify the name, default flag, and/or active flag
of an existing workflow, change the values in the appropriate text-box, radio-button, or drop-down list and
click the “Save” button. To add a new workflow, click the ‘Add Workflow’ link and a new workflow will be
created with the standard SpiraTeam® steps and transitions.

Note: You can only assign an active workflow to a test case type, and similarly you cannot make a
workflow inactive that is currently linked to a test case type. This is important as all test case types need
to be linked to an active workflow at all times.

3.7.2.1. Edit Workflow Details

Clicking on the ‘Steps’ hyperlink of a workflow brings up the following screen that lists all the workflow
steps and workflow transitions that comprise the workflow:

This page lists in the left-most column all the various test case statuses defined in the system. The next
column lists all the possible transitions that can occur from that status. In addition, with each transition is
listed the name of the resulting destination status that the transition leads to. E.g. from the Draft status,
depending on your role (see later) the user can move the test case to either Rejected, or Ready for
Review, depending on which transition the user takes.

Clicking on the name of a step or transition takes you to the appropriate details page (see below) where
you can set the properties of the step or transition respectively. To delete an existing transition, click the
‘x button after the transition name, and to add a new transition, click the ‘Add Transition’ button in the
Operations column.
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3.7.2.2. Edit Workflow Transition

When you click on the transition name link from the previous screen, you are taken to the workflow
transition details screen:

The top part of the screen is the “workflow browser” which illustrates how the transition relates to the
workflow as a whole. It displays the current transition in the middle, with the originating and destination
steps listed to either side. Clicking on either task status name will take you to the appropriate workflow
step details page. This allows you to click through the whole workflow from start to finish without having to
return to the workflow details page.

This part of the screen lets you change the name of the transition. If a digital signature from the user is
required to authorize and record the transition, set the toggle to yes for “Require Electronic Signature”.

In addition, each transition has a series of conditions which need to be satisfied for a user to actually
execute the transition (i.e. move the test case ease from the originating status to the destination status):

The conditions section allows you to set three types of user role:

» The author of the test case can be allowed to execute the transition. For example, when a test
case is marked as Ready for Review, the author might be allowed to move it to Ready to Test.
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» The owner of the test case can be allowed to execute the transition. For example, when a test
case is marked as Approved, the assigned owner should be the only one who’s allowed to move
it to Ready for Test.

>» A user with a specified role can be allowed to execute the transition regardless of whether they
are the author or owner. For example a user with role “Manager” might want the power to
approve all test cases regardless of ownership status.

You can set any of these conditions by changing the drop-down list and/or check-boxes and clicking
the appropriate “Save” button.

3.7.2.3. Edit Workflow Step

When you click on the test case status name link from either of the previous screens, you are taken to the
workflow step details screen:

The top part of the screen is the “workflow browser” which illustrates how the step relates to the workflow
as a whole. It displays the current test case status in the middle, with the possible originating and
destination transitions listed to either side. Clicking on either workflow transition name will take you to the
appropriate workflow transition details page. This allows you to click through the whole workflow from
start to finish without having to return to the workflow details page.

This page allows you to define the behavior of the various test case fields (i.e. those that are a standard
part of SpiraTeam® such as Priority):

© Copyright 2006-2016, Inflectra Corporation Page 82 of 126 This document contains Inflectra proprietary information




This page also allows you to define the behavior of the various test case custom properties for this
particular step in the workflow:

You can set each of the fields/custom properties as being:
» Hidden — The field / custom property will not be displayed when the test case is in this status
> Disabled — The field / custom property will be displayed, but will be greyed-out and read-only
>» Required — The field / custom property will be required when the test case is in this status

Note that you cannot set a field/property as being required and either disabled or hidden since this would
prevent a user from ever updating the test case. For example, when a test case is in the Draft status, you
might make the owner field hidden (since the author shouldn’t need to know who will ultimately own it),
when it gets to the Ready for Review status, you might make the field enabled and required, and when it
gets to the Approve status, you might make it disabled. This allows you to tailor the information gathered
to the appropriate place in the workflow.

To actually make these changes, all you need to do is select the appropriate checkboxes in the list of
fields and custom properties and click the corresponding “Save” button.
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3.7.2. Testing Settings

Clicking on the “Testing Settings” link under the Testing heading, brings up a list of options that the
administrator and project owner can configure regarding testing. Select from the options displayed (as
illustrated below) and click “Save” to commit the changes.

You can enable or disable the following settings:

o Display Build During Test Execution — During test execution the system can display a drop-
down list of builds associated with the selected release. If you are using SpiraTeam in conjunction
with a build server such as Jenkins/Hudson, you should choose “Yes”, otherwise we recommend
hiding the list of builds (to avoid confusing your testers) by choosing “No”.

e Auto Unassign Tests — When a tester passes an assigned test case or all the test cases in an
assigned test set the system by default will automatically un-assign the test case / test set from
the user. To prevent this from happening, change either setting to “No”.

e Auto create a test step - Automatically creating a default test step on the creation of any test
case

o Worx Integration — Integrating with the Worx desktop application

3.8. Notifications

This section allows the administrator and project owner to configure email server configuration, email
notification content, and when notifications are sent. Server configuration and artifact templates can only
be changed by the system Administrator. However, notification events can be configured by the project
owner.

3.8.1 Email Configuration

The Email Configuration page is split into two sections. The first section covers email notification details,
and the second section configures how email from the application is sent.
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Email Configuration

By default, SpiraTeam will use the default 115 SMTP Virtual Server to send outgoing email notifications to users in the system. However, it can also
be configured to send emails through an external SMTP server directly.

This page allows you to change these mail server settings:

E-Mail Notifications Active?” Yes

If disabled, SpiraTeamn will not send out any messages.

From E-Mail Address:* administrator@mycompany.com

The address that emails will be sent from. Replies to this address will not be monitored.

Reply-To E-Mail Address:

The Reply-To field that emails sent will contain. Blank will leave header field blank in messages.

Send HTML Emails:* Yes

If enabled, emails will be sent out in HTML. Otherwise, plain text.

Allow Users Control of Yes
Py . 7.
Receiving Emails? If enabled, users will be given the option to deny receiving emails from the system.

Emails From User Addresses?” Yes

If enabled, any messages sent using the Email button will appear from the user that initiated the Email, and not the
System Administrator.

Send Email Importer No

Separator?”
If enabled, all emails going out will contain the separator needed to clean up replies that are converted into
comments.

o Email Notifications Active? — Defaults to Yes. If changed to No, the system will not send out
any emails, regardless of other settings. Note that this means that new user requests will not get

sent either.

e From Email Address — This is the email address specified in the ‘From:’ field of email
notifications sent from the application.

¢ Reply-To Email Address — This is the address specified in the ‘ReplyTo:’ field for notification

emails sent from the application.

¢ Send HTML Emails? — Defaults to Yes. This option specifies whether HTML or Plain-Text emails

are sent from the system.

¢ Allow Users Control of Receiving Emails? — Defaults to Yes. This specifies whether or not a
user can modify their profile to not receive any emails from the system. If set to no, users’
preference will be enabled and locked out.




To use the internal IIS’s default virtual SMTP server, leave all fields blank. The virtual server must then be
configured to use proper SMTP server and network configuration. If you want the application to contact
an SMTP server directly, use the following fields:

e Host Name — This is the SMTP server to connect to.
e Port Number - This is the port number to use, blank uses the default port 25.

e SSL Connection — Whether or not to use an SSL connection with the server. Be sure that the
SMTP server's SSL certificate is trusted on the application server.

¢ User Name — When using an authentication method, this is the username to log in as.

o Password — When using an authentication method, this is the password to use.
Example settings for connecting to Gmail/Google Mail for sending notifications:

+ Host Name: smtp.gmail.com

% Port Number: 587

% SSL Connection: Yes

< User Name: “account’@gmail.com

« Password: “account password”

3.8.2 Notification Templates
Notification templates are used by notification events, and are defined system-wide for each artifact type.

© Copyright 2006-2016, Inflectra Corporation Page 86 of 126 This document contains Inflectra proprietary information




Notification Templates

Here you can specify the e-mail notification templates sent out for each Artifact type. To edit the template, select the Edit Template link.
To send a test e-mail using the template, select the Test Template link. The test e-mail will be sent using the first item in the project.

Artifact Type Prefix Operations

Document DC £ Edit EITest
Incident IN (& Edit EATest
Requirement RQ ' Edit Test
Task TK (& Edit EATest
Test Case TC £ Edit EITest
Test Set ™ (& Edit EATest

To edit a template, click the Edit button. To send a test email notification to yourself using the specified
template, click the Test button.

Clicking the Edit button will take you to a page similar to the following. Depending on the artifact type you
selected, the list of available fields will vary.

On this screen you are presented with the same rich text editor available elsewhere in the application.
Displayed in it is the current template (with template tags showing) for the artifact. Template tags start
with a $ (dollar sign) and then a string name enclosed in {} parentheses. When email notifications are
sent, tokens will be replaced with specific information from the artifact that the notification is being sent
for. Invalid tokens will be stripped from the template text. Clicking the link “(Display Email Template Field
Tokens” to see a list of available tokens to insert into the textbox for easy selecting and editing.




SIATHSS  SdHEenursment=sIaniss

| Email Notification Tokens

i The following are all available tokens for Requirements and their meanings. Tokens not in this list will be taken out of the final
message. Click on a token to insert it into the current cursor position in the editor above.

! ${Author} The name of the Author ${Comments} The requirement comments
${Component} The component the requirement is a part of ${Description} Descriptive text
${EstimatePoints} The estimate in story/function points ${lmportance} The current Importance
$iNamel MName of the Requirement ${Owner} The name of the Owner
${Release} The Requirement's Assigned Release. ${RequirementStatus! The current Status
${RequirementType} The requirement type ${TaskActualEffort} Assigned Task's actual effort in HH:MM
${TaskEstimatedEffort] Assigned Task's planned effort in HH:MM ${TaskProjectedEffort! Assigned Task's projected effort
${TaskRemainingEffort} Assigned Task's remaining effort S{URL}Y URL to link to artifact.
${NotifyTol The notification receiver's name. ${Product} The name of the application.
${ProjectNamel The name of the project. S{ID#} The ID# of the item.

If HTML notifications are disabled, the template will be converted to plain text before sending.

When finished, click the update button to save your new template. The new template will take effect
immediately.

3.8.3 Notification Events

The Notification Events section is where project managers can set up when and to whom notifications are
sent out to users of the system. Clicking on the Notification Event link will present you with a list of all
events defined for the current project:

Notification Events Library Information System

< Change Project

The fallowing notification events have been defined for this project. To activate or deactivate an event or change assigned fields or users, click the
'Edit’ link.

+ Add

Event Name Artifact On Creation? Active? Operations

Incident: Newly Created Incident Yes Yes (£ Edit X Delete
Incident: Owner Assigned Incident No Yes # Edit ® Delete
Requirement: Newly Created Requirement Yes Yes  Edit X Delete
Requirement: Owner Assigned / Importance Requirement No Yes # Edit X Delete
Task: Newly Created Task Yes Yes & Edit ® Delete
Task: Owner or Priority Changed Task No Yes (£ Edit = X Delete
Test Case: Executed Test Case No Yes @ Edit = X Delete
Test Set: Execution Changed Test Set No Yes ( Edit | % Delete
Test Set: Newly Created Test Set Yes Yes (£ Edit X Delete

Note that these events do not override nor cancel any notifications configured for Incident Workflows. To adjust settings based on Incident
Status changes and workflow steps, please go to the View/Edit Workflow page.

Go to Edit Workflows




Note: These events can handle all changes to any of the artifacts except changes handled by Status
changes to Incidents. Incident status changes are handled through the Workflow configuration.

When clicking on the Edit or Add buttons, you will be presented with the event details screen:

Incident: Newly Created Notification Events

€ Back to Notification Event List

Event details are listed below. You can edit the fields and users and whether or not this event is fired on creation, but once created the Artifact
Type cannot be changed.

Once finished, click [Save] or [Insert] to save your changes.

Event Name:* Incident: Newly Created

Artifact Type:* Incident
This event will be attached to this artifact type.

On Creation?™ Yes

Whether this event is fired on a new artifact creation.

Subject Line:* ${Product}- A new incident has been opened in ${ProjectName}

The subject-line of the e-mail notification. Tokens used in the email template can be used in the subject line.

(Display Email Subject Special Tokens)

Configuration:
Artifact Fields Users and Project Roles

The top section defines general configuration items for the event:
o Event Name: used to name the event, only used for administrative purposes.

o Artifact Type: The artifact type this event is attached to. Once an event is created, the artifact
type cannot be changed.

e On Creation? If set to yes, this event will fire when an artifact is created, as well as when any
configured fields are changed.

o Active? If set to yes, this event is active and will send notifications when configured fields are
modified.

o Subject Line: The subject line of the notification email.

The Artifact Fields will let you configure which fields will cause this notification to send an email
notification:




Selected fields are treated in an OR-based query, so that if you have two or more fields checked for an
event, the event will send a notification if either of the two fields are changed. Depending on the artifact

type configured above, the available fields will vary.

The last section is the configuration of whom to send the notifications to:




If a user belongs to more than one group or they have manually signed up to receive notifications to any
changes in the artifact, they will only receive one notification for the artifact change.

3.9. Documents

SpiraTeam® includes a built-in web-based document management system that allows you to upload and
share documents between project team members. These documents are stored in folders, categorized by
a series of user-defined meta-tags and can also be associated with other artifacts in the system (e.g.
requirements, incidents, etc.).

The set of administrative options located under the “Documents” heading allow the Project Owner to
configure how the documents are organized in their particular project.

3.9.1. Edit Document Types

When users upload documents into a SpiraTeam project, they are required to specify the type of
document that is being uploaded. The list of document types is configurable by the Project Owner for
each individual project.

When you click on Documents “Edit Types”, you can edit the list of types available:

By default, each project will be created with a single document type called ‘Default’. You can add
additional document types and/or change the name of the ones already created. If you decide that you no
longer want to use a specific document type, you can set its active flag to “No”.

The only requirement is that each project needs to have at least one active document type available, and
that there is one active type designated as the default type. The default type is the option that will be
initially selected when a user uploads a file / URL to the project.

3.9.2. Edit Document Folders

In addition to associating the documents in the system with a “document type”, they can also be
organized into a hierarchy of folders. Clicking on Documents “Edit Folders” allows the Project Owner to
create / modify the folder structure into which users can upload the documents for sharing and
collaboration:
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Initially, new projects are created with a single folder called “Root Folder”, under this folder, you can click
the [Add] button to add additional folders, “Edit” to change the name and/or location of an existing folder,
or “Delete” to permanently remove a folder. Note that deleting a folder will remove all its subfolders and
any documents contained in the folder and subfolders.

When you click on either [Add] or [Edit], you will be taken to the following screen that allows you to edit
the details of the new/modified folder:

Test Scri ptS Add / Edit Document Folder

Please review the information listed below and make any changes if necessary.
Once you have finished, click [Save/Insert] to confirm them.

Folder Name:" Test Scripts

Parent Folder: Root Folder v

Save Cancel

The first field allows you to specify the name of the folder as it will be displayed to users in the system,
and the second field allows you to tell the system which parent folder should contain the new folder. You
cannot make the root folder a child of an existing folder, and there can only be a single root folder per
project.




3.10. System

3.10.1. General Settings

The general settings page allows you to configure SpiraTeam® to better match your environment and
setup. In the current version, you can specify the default language, or configure the folder used to store
document attachments:

The available settings include:

Default Culture — SpiraTeam can display information in a variety of different languages
(assuming that the appropriate language packs have been installed) and number formats. By
default, SpiraTeam will use the regional settings (language and number formats) of the operating
system it has been installed on. However, you can override this default by choosing the




appropriate culture from the list of options displayed in the drop-down list. Note: The list of culture
options does not reflect the available language packs, so in some cases, the setting will only
change the number formats.

o Default Timezone — SpiraTeam stores all dates and times internally in Universal Coordinated
Time (UTC) and can therefore display dates/times adjusted for different timezones. By default,
SpiraTeam will display dates in the timezone specified in the operating system it has been
installed on. However, you can override this default by choosing the appropriate display timezone
from the list of options displayed in the drop-down list.

e Web Server URL - This is the URL that your users use to access the system. Do not put the
/Login.aspx or any other page here, as this URL is used to generate links to pages in the
application.

e Attachments Folder - By default when SpiraTeam® is installed, the document attachments
uploaded in the system get stored inside the C:\Program Files\SpiraTeam\Attachments folder
located inside the main SpiraTeam® installation root. However you may want to have the
documents stored on a remotely mounted drive or on a different hard disk partition. In which case
you can simply change the folder pointed to in the text-box illustrated above and then click
[Update] to commit the change.

e Cache Folder — By default when SpiraTeam needs to store temporary data (generated reports,
the version control cache, etc.) it will store them in the C:\ProgramData\Inflectra\Spira folder.
Sometimes this folder is not appropriate (e.g. you want them on a different drive that has more
space). You can enter in a different folder for temporary storage and SpiraTeam will use that
instead.

e Login Notice — this can be used system wide to set a message to permanently display at the
bottom of the login screen for all users (for example, a company disclaimer).

¢ Administration Message — this can be used by the administrator to display a temporary notice
displayed on the login screen for all users. For example it could be used to remind all users that
the server will be down for upgrading over the weekend. The administrator should delete the
message once it is no longer needed.

¢ Instant Messenger — SpiraPlan and SpiraTeam come with a built-in instant messenger that
allows users to communicate with each other in real-time. This can result in higher levels of
network traffic and some system administrators may wish to disable this feature. This option lets
you disable the integrated instant messenger. In addition, you can specify how long (in days)
instant messages are retained in the system.

o Event Log Retention — As described in section 3.10.7, SpiraTeam comes with a built-in
diagnostic event log. By default the system will only retain the last 30-days of events to avoid
wasting storage space. You can adjust the retention period in this section to match your
organization’s policies.

o Enable Free Text Indexes — This tells SpiraTeam to use SQL Server Free Text Indexing to
speed up keyword searches in the Global Search box. You should only have this set to “Yes” if
you have the Free Text Indexing featured enabled in SQL Server, otherwise you will cause
SpiraTeam to display error messages when users try and use the global search.

3.10.2. File Type Icons

The “File Types List” administration page allows you to view all the different filetypes that are recognized
by SpiraTeam and add or edit the associated icon, name, description and MIME type:
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If you click on the “Edit” button next to a filetype, or click on the “Add” button at the bottom of the screen,
the system will display the page that lets you add or edit a filetype entry:

Edit/ Add File Type

This is the definition for the file type with the given extension. Entering in values here simply helps with displaying correct file information on
the Source Control and Documents pages with attachments. All fields are required, blank fields will be set to the default. The icon image
must exist on the web server in the active theme directory under "Filetypes”,

Filetype ID: 3

File Extension: aspx

File Description: ASP Page
Mime Type: text/plain
File Icon Image: [ASP—Net.giﬂ

On this page you can enter/edit the file extension that’'s used to recognize the type of file uploaded, the
description of the file type (displayed in popup tooltips), the MIME type (used to determine how the
browser handles the file type) and the path to the icon image. Once you are satisfied with the values, you
can click on the “Save” button to confirm the changes.

3.10.3. Edit Reports

The “Edit Reports” administration page lets you create custom reports in the system that your users can
run in the various projects they have access to. Note that the report definitions themselves are global to
the system and therefore available in all projects.




The list of report definitions contains both the standard (default) reports that ship with the system and any
custom reports that you have defined. However any of the reports listed with the “Default” option checked
will not be editable. So, if you want to modify one of the built-in reports to make it better suit your needs,
you should instead click on the “Clone” button next to the report and make a copy of the report that you
can then modify. You can view any of the default reports by clicking on the associated “View” button.

To edit an existing non-default report, click on the “Edit” button. To add a new report from scratch, click on
the “Add New Report” option at the bottom of the list. Either of these will take you to the Report editing
screen:




The top-half of this screen (illustrated above) lets you specify the name of the report, the long description
(displayed in tooltips but not in the report itself) and a rich-text footer and header. The header and footer
will be displayed at the top and bottom of the generated report.

In addition, you can specify whether the report is active (and therefore can be used in the SpiraTeam
reports center) and which report category heading the report will appear in. This is also used to determine
which role(s) are able to run the report (e.g. a user that has permissions to view requirements will be able
to run all reports listed under the “Requirement Reports” category).

The lower-half of the screen displays the list of formats, standard sections and custom sections that make
up the report:

The list of formats is fixed in the system, you can simply choose which formats this specific report will be
available in. The reporting engine will take care of converting your report into the target format, you just
need to specify which type(s) are applicable.

a) Standard Sections

The list of standard sections contains a list of the various pre-defined report sections that are to be
included in the report. A standard section consists of a set of nested queries and embedded elements
that will return back data. For example, the “Requirements Details” section consists of a list of all the
requirements in a project, together with the associated test cases, tasks, custom properties, attachments,
discussions, change history, source code revisions and other related items.

With a standard section, you cannot change the underlying data query, but you can change the header,
footer and XSLT template used to format the results:
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When you either click on “Add New Standard Section” or the “Customize® link next to an existing standard
section, the popup dialog illustrated above will be displayed. On this page you can change the following
fields:

¢ Name — Choose the name of the standard report section you want to use from the dropdown list.
Changing the name of the section will automatically update the Description field below.

o Description — This is the description of the report section, it is not displayed in the final report.

o Header — This is the header that will be displayed before the dynamic data retrieved as part of
the report section. You can enter in formatted rich text in this field.

o Footer — This is the footer that will be displayed after the dynamic data retrieved as part of the
report section. You can enter in formatted rich text in this field.

o Template — This is the eXtensible Markup Language Stylesheet Transform (XSLT) used to
transform the raw XML data from the report query into the final HTML display format. When you
choose/change the name dropdown list, clicking on the “Create Default Template” will populate
this field with the default template used to render the data.

When you first create a new standard report section, we recommend using the option to “Create Default

Template”. This will then allow you to run the report in the main reports center and have all the available

data fields displayed in the standard format. If you would like to customize the content of the section, you
have several options:

e Customize Header/Footer — if you want to keep the data and layout as-is, you can simply add a
custom header and footer to add organization specific information into the report.

o Customize the Data/Layout — if you want to customize how the data is displayed and formatted,
you will need to edit the XSLT Template. You can learn more about XSLT at the W3Schools
website (http://www.w3schools.com/xsl). However, the recommended approach is to first run the
“Raw XML” format report from the main SpiraTeam reports center. An example XML report is
partially shown below:

“2xml version="1.0" encoding="UTF-8" standalone="yes"?”
“Report”
“Title”
Requirements Detailed Report
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http://www.w3schools.com/xsl

“/Title”
“ProjectData”
“Project”
“Projectld”l1”/Projectld”
“ProjectGroupld”2”/ProjectGroupld”
“Name”Library Information System”/Name”
“Description”Sample application that allows users to manage books, authors and lending
records for a typical branch library”/Description”
“Website”www. libraryinformationsystem.org”/Website”
“CreationDate”2005-11-30T19:00:00”/CreationDate”
“ActiveYn”Y”/ActiveYn”
“WorkingHours”8”/WorkingHours”
“WorkingDays”5”/WorkingDays”
“NonWorkingHours”0”/NonWorkingHours”
“TimeTracklncidentsYn”Y”/TimeTracklncidentsyYn”
“TimeTrackTasksYn”Y”/TimeTrackTasksYn”
“EffortincidentsYn”Y”/EffortincidentsYn”
“EffortTasksYn”Y”/EffortTasksYn”
“TasksAutoCreateYn”Y”/TasksAutoCreateYn”
“RegDefaul tEffort~480”/ReqgDefaul tEffort”
“TaskDefaul tEffort”360”/TaskDefaul tEffort”
“ProjectGroupName” Internal Projects”/ProjectGroupName”
“/Project”
“/ProjectData”
“RequirementData”
“Requirement”
“Requirementld”1”/Requirementld”
“Projectld”l”/Projectld”
“ScopelLevel1d”3”/ScopeLevel 1d”
“Authorld”2”/Authorid”
“Name”Functional System Requirements”/Name”
“CreationDate”2003-11-30T19:00:00”/CreationDate”
“LastUpdateDate”2003-11-30T19:00:00”/LastUpdateDate”
“IndentLevel ”AAA”/IndentLevel”
“ExpandedYn”Y”/ExpandedYn”
“VisibleYn”Y”/VisibleYn”
“SummaryYn”Y”/SummaryYn”
“AttachmentsYn”N”/AttachmentsYn”
“CoverageCountTotal”21”/CoverageCountTotal”
“CoverageCountPassed”10”/CoverageCountPassed”
“CoverageCountFailed”3”/CoverageCountFailed”
“CoverageCountCaution”1”/CoverageCountCaution”
“CoverageCountBlocked”1”/CoverageCountBlocked”
“PlannedEffort”8700”/PlannedEffort”
“TaskEstimatedEffort”11400”/TaskEstimatedEffort”
“TaskActualEffort”7570”/TaskActualEffort”
“TaskProjectedEffort”3855”/TaskProjectedEffort”
“TaskRemainingEffort~11485”/TaskRemainingEffort”
“TaskCount”42”/TaskCount”
“TaskPercentOnTime”59”/TaskPercentOnTime”
“TaskPercentLateFinish”6”/TaskPercentLateFinish”
“TaskPercentNotStart”7”/TaskPercentNotStart”
“TaskPercentLateStart”28”/TaskPercentLateStart”
“ScopeLevelName” In Progress”/ScopelLevelName”
“AuthorName”Fred Bloggs”/AuthorName”
“HasDiscussionChanged”false”/HasDiscussionChanged”
“1sDeleted”false”/1sDeleted”
“CustomProperties”
“CustomProperty”
“Alias”URL”/Alias”
“Name”Custom_01"”/Name”
“Type”Text”/Type”
“/CustomProperty”
“CustomProperty”
“Alias”Difficulty”/Alias”
“Name”Custom_02”/Name”
“Type”List”/Type”
“/CustomProperty”
“CustomProperty”
“Alias”Requirement Type”/Alias”
“Name”Custom_03”/Name”
“Type”List”/Type”
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“/CustomProperty”

“CustomProperty”

“Alias”Notes”/Alias”
“Name”Custom_04”/Name”
“Type”Text”/Type”

“/CustomProperty”

“CustomProperty”

“Alias”Review Date”/Alias”
“Name”Custom_05"”/Name”
“Type”Date”/Type”

“/CustomProperty”

“CustomProperty”

“Alias”Decimal”/Alias”
“Name”Custom_06"/Name”
“Type”Decimal”/Type”

“/CustomProperty”

“/CustomProperties”
“Discussions /”
“TestCases /”
“Tasks 7/~
“Attachments /”
“History”

“HistoryChangeSetType”
“ChangeTypeld”1”/ChangeTypeld”
“ChangeTypeName”Modified”/ChangeTypeName”

“/HistoryChangeSetType”

“HistoryChangeSetType”
“ChangeTypeld~2”/ChangeTypeld”
“ChangeTypeName”Deleted”/ChangeTypeName”

“/HistoryChangeSetType”

“HistoryChangeSetType”
“ChangeTypeld”3”/ChangeTypeld”
“ChangeTypeName”Added”/ChangeTypeName”

“/HistoryChangeSetType”

“HistoryChangeSetType”
“ChangeTypeld”4”/ChangeTypeld”
“ChangeTypeName”Purged”/ChangeTypeName”

“/HistoryChangeSetType”

“HistoryChangeSetType”
“ChangeTypeld”5”/ChangeTypeld”
“ChangeTypeName”Rol lback”/ChangeTypeName”

“/HistoryChangeSetType”

“HistoryChangeSetType”
“ChangeTypeld”6”/ChangeTypeld”
“ChangeTypeName”Undelete”/ChangeTypeName”

“/HistoryChangeSetType”

“HistoryChangeSetType”
“ChangeTypeld”7”/ChangeTypeld”
“ChangeTypeName” Imported”/ChangeTypeName”

“/HistoryChangeSetType”

“HistoryChangeSetType”
“ChangeTypeld”8”/ChangeTypeld”
“ChangeTypeName”Exported”/ChangeTypeName”

“/HistoryChangeSetType”

“/History”
“Requirements /”
“Incidents /”
“SourceCodeRevisions /”
“/Requirement”
“/RequirementData”
“/Report”

This XML data is then converted by the XSLT template into HTML format so that it can be included into
the final generated report. An example fragment of the XSLT template looks like:

w?xml version="1.0" encoding="utf-8"?"
“xsl:stylesheet version="1.0" xmIns:xsl="http://www.w3.0rg/1999/XSL/Transform"
xmIns:msxsl=""urn:schemas-microsoft-com:xslt" exclude-result-prefixes="msxsl""
“xsl:template match="/RequirementData""
“xsl:for-each select="Requirement'"
~div”
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“xsl:attribute name="style""
padding-left: “xsl:value-of select="string-length(IndentLevel)*2"/"px;
“/xsl:attribute”
“xsl:if test=""SummaryYn="Y"""
“div class="Title2""
RQ:”xsl:value-of select="Requirementld"/” - “xsl:value-of select="Name"/”
~/div”
“div class="Description"™"
“xsl:value-of select="Description” disable-output-escaping="yes"/”
“/div”
“br /7~
“Ixshzif”
“xsl:if test=""SummaryYn="N""""
“xsl:attribute name="style""
padding-left: “xsl:value-of select="string-length(lndentLevel)*2"/"px;
“/xsl:attribute”
“div class="Title3""

RQ:”xsl:value-of select="Requirementld"/” - “xsl:value-of select="Name"/”
“/div”
“xsl:value-of select="Description" disable-output-escaping="yes"/"”
\\/p//
“xshzif”
~/div”

“/xsl:for-each”
“/xsl:template”

So using a combination of XSLT and the Raw XML report format, you can generate a customized view of
the standard report section that will be included in the final report.

Sometimes, however you want to be able to create a completely custom report that includes customized
data as well as a custom format. In which case you need to use a custom report section instead.

b) Custom Section

Back on the main report details page, if you click on “Add New Custom Section”, the following dialog box
will be displayed:

On this page you can enter / change the following fields:

¢ Name — Enter the name of the new custom report section that you will be adding to the report.
This is not displayed in the final report
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o Description — This is the description of the custom section, it is not displayed in the final report.

o Header — This is the header that will be displayed before the dynamic data retrieved as part of
the report section. You can enter in formatted rich text in this field.

o Footer — This is the footer that will be displayed after the dynamic data retrieved as part of the
report section. You can enter in formatted rich text in this field.

e Active — You should make sure this checkbox is checked if you want the custom section to
appear in the final report.

Further down on the page you can actually enter the custom query and associated XSLT template:

On this page you need to first choose the appropriate reportable entity from the dropdown list. In the
example illustrated above, we have selected the “Requirements” reportable entity. This will automatically
populate the following query in the Query editor:

select value R from SpiraTestEntities.R_Requirements as R where R.PROJECT_ID = ${Projectlid}

This query tells SpiraTeam to select all of the rows in the R_Requirements collection that are in the
current project and include all of the columns in the final report. This generally will result in more columns
than is desirable, so you should click on the “Preview Results” option to view a list of the various columns
and the sample data. That will help you decide which columns are important for your report. You can then
adjust the query to only include those columns:

select R.REQUIREMENT_ID, R.NAME from SpiraTestEntities.R_Requirements as R where R.PROJECT_ID =
${Projectlid}

In this modified query, we have replaced the keyword value with the specific column names. When you
use the “Preview Results” option on this query, you will only see the two desired columns:
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Once you have verified that the data being returned matches your requirements, click on the “Create
Default Template” option and SpiraTeam will automatically generate a new XSLT template that displays
just these columns in a nice table format:

You can now click the [Save] button to save your changes to the report.

You may have noticed that we had a special token in the query ${Projectld}, this token will be evaluated
during the generation of the report and ensures that only items in the current project are included. If you
want to include all the items in a specific Project Group, you should instead use the token
${ProjectGroupld}. If you don’t use either token, the report will include all the items in the entire system,
across all projects and groups.

For example:

e select value R from SpiraTestEntities.R_Requirements as R where R.PROJECT_ID =
${Projectid}

will display all the requirements in the specific project
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e select value R from SpiraTestEntities.R_Requirements as R where R.PROJECT_GROUP_ID =
${ProjectGroupld}
will display all the requirements in the specific project group

e select value R from SpiraTestEntities.R_Requirements as R
will display all the requirements in the entire system

For more information on creating custom report queries, please refer to the knowledge base articles on
the Inflectra customer support website: http://www.inflectra.com/Support.

Warning: If you create a report that doesn’t have either ${Projectld} or ${ProjectGroupld} in the WHERE
clause you could end up displaying data to a user that shouldn’t have permission to see that data.

3.10.4. License Details

The license details page displays the information about the installed license for the particular instance of
SpiraTeam® being used. The information displayed includes: the product name (e.g. SpiraTeam), the
license version (e.g. v4.1.0.0), type of license in effect (x-user fixed, x-user concurrent, demonstration,
enterprise, etc.), the organization that the license belongs to, the actual license key code and finally the
number of users concurrently logged-in. This last piece of information is useful as it helps administrators
track down how many licenses are currently in use.

A sample page is illustrated below:

To change the license key used by the system (for example, if to upgrade from Trial edition to Standard
edition), you do not need to reinstall SpiraTeam®. All you need to do is simply change the information in
the organization and license key text-boxes to match the license key and organization name found in
the customer area of our website (http://www.inflectra.com/CustomerArea) and click the “Update” button.

If there is an issue with the license key (e.g. a trial version that is passed its expiration date, or where the
license key doesn’t match the organization name) an error will be displayed describing the specific issue
with the information you entered. If you are unable to get the system to work with the license key
information, please contact Inflectra® customer support at: support@inflectra.com.
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3.10.5. LDAP Configuration

As described previously, you can configure SpiraTeam® to use an external LDAP server for importing
new user profiles into the system, and for authenticating users — instead of having to store separate
passwords inside SpiraTeam®. However you need to first configure the LDAP server settings. To do this,
click on the “LDAP Configuration” link the Administration navigation:

You need to fill out the various configuration settings for your LDAP server, each of which is explained in
more detail below:

> LDAP Host
This should contain the name of the LDAP server that you want SpiraTeam to connect to together
with the port number if it's not the default of 389.

» Use Secure Sockets Layer (SSL)
You should select this check-box if your LDAP server requires use of the LDAPS secure protocol.
Leave unchecked for unencrypted LDAP communication.

> Base DN
This should be the distinguished name of the object inside your LDAP server that contains the list
of user accounts. This varies by the type of LDAP server, please consult your LDAP server
documentation for more details.

> Bind DN
This should be the distinguished name of the user inside your LDAP server that will be used to
authenticate against when importing users. If not provided, SpiraTeam® will try and authenticate
with the LDAP server anonymously.
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> Bind Password
The is the password of the user specified in the Bind DN field above.

> Login Attribute
When SpiraTeam® imports users from the LDAP server it needs to know the user attribute inside
the LDAP server that it should use to generate the SpiraTeam® user-name. For most LDAP
servers the appropriate attribute would be “uid”. However for Windows ActiveDirectory, the
attribute “sAMAccountName” should be used instead.

> First Name Attribute
Providing this optional attribute will allow SpiraTeam® to automatically populate the first name
field of the imported user instead of simply using the username as a placeholder.

>» Last Name Attribute
Providing this optional attribute will allow SpiraTeam® to automatically populate the last name
field of the imported user instead of simply using the username as a placeholder.

> Middle Initial Attribute
Providing this optional attribute will allow SpiraTeam® to automatically populate the middle initial
field of the imported user instead of simply leaving it blank.

>» Email Address Attribute
Providing this optional attribute will allow SpiraTeam® to automatically populate the email
address field of the imported user instead of simply using the username@spiratest.com as a
placeholder.

» Sample User
You can optionally enter a sample user and password to test that the user is correctly
authenticated against the server. You can update the LDAP configuration without setting this, but
if you do provide a sample user/password, it will not save the configuration unless the
authentication succeeds. If you choose to enter it, the user's name should be the fully-
distinguished name of the user (e.g. CN=Sample User, CN=Users, OU=Headquarters,
DC=MyCompany, DC=Com).

3.10.6. Security Settings

The “Security Settings” administration page lets you specify the various security settings within
SpiraTeam to match your organization’s policies and processes:
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The following settings can be changed within the system, once you are satisfied, click the “Update” button
to commit the changes:

>

© Copyright 2006-2016

Allow User Registration — Set this to “Yes” if you want to allow users to self-register for
SpiraTeam accounts (that you can subsequently approve). If you set this to “No”, a system
administrator will need to create all user accounts. Also set this to “No” if you plan on using
LDAP-based authentication.

Maximum # Invalid Password Attempts — Set this to the number of times a user can enter an
incorrect password before their account is temporarily locked out. This is important in preventing
‘brute force’ password hacking attempts.

Minimum Required Password Length — Set this to the minimum length of passwords in the
system. Choosing a longer password will make it harder for an unauthorized user to crack a
password and gain entry into the system.

Minimum Required Special Characters - Set this to the minimum number of non-alphanumeric
characters that will be required for passwords in the system. Choosing more required special
characters will make it harder for an unauthorized user to crack a password and gain entry into
the system.

Password Attempt Time Window — Set this to the duration (in minutes) after which a user’s
account will be automatically unlocked (due to repeated incorrect password attempts).

Authentication Expiration — This specifies the amount of time (in minutes) after which a user
will be logged out due to inactivity when they login without choosing the ‘Keep Me Logged-In’
option.
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> Keep Me Logged-In Expiration - This specifies the amount of time (in minutes) after which a
user will be logged out due to inactivity if they have chosen to login with the 'Keep Me Logged-In

option. This should normally be longer than the previous setting.

3.10.7. Event Log
The “System Event Log” administration page lets you view all of the errors, warning and other diagnostic

messages that have been logged in the system:

Each event entry is displayed along with the date-time it occurred, the type of event (error, warning,

information, success audit, failure audit), category (application, source code provider, data-
synchronization) and the short name. To view the full message, click on the “View Iltem” hyperlink:




The popup dialog box will display the full error message log and stack trace in a moveable dialog box.
This information should be provided to Inflectra customer support if you log a help desk ticket.




3.11. Integration

3.11.1. Data Synchronization

SpiraTeam® is capable of synchronizing its data with a variety of other systems, including but not limited
to requirements management systems and standalone bug-tracking tools. The various integration plug-
ins for SpiraTeam® and the steps for configuring the data-synchronization settings are described in the
SpiraTest External Bug-Tracking Integration Guide.

If you are synchronizing data between SpiraTeam® and one of these other systems, you can click on the
‘Data Synchronization’ administration page at any time and view a list of all the data-synchronizations
taking place, together with the status and date/time of last synchronization:

In the example above, we have four plug-ins active, with incidents being exported into JIRA, Bugzilla,
FogBugz and Microsoft Team Foundation Server. The data of last sync and the status indicate if there are
problems with the plug-in.

The ‘Refresh’ button allows you to refresh the status of the page to ensure that you are seeing the most
up to date information. In certain circumstances you may want to reset the date of last sync and force a
particular plug-in to examine all the records in the system to see if any were not synchronized - clicking
on the ‘Force Complete Re-Sync’ button will achieve this. The recommended procedure for forcing a re-
sync is to temporarily stop the SpiraTeam Data-Sync background Windows service, click the button to
reset the last-sync date, and then start the service. This will ensure that the resetting doesn’t happen mid-
sync.

3.11.2. Version Control Integration (On-Premise Customers Only)

This section refers to the functionality available to on-premise customers of SpiraTeam. If you are using
the cloud / hosted version of SpiraTeam, please refer to section 3.11.4 (TaraVault Configuration) instead.

SpiraTeam® is capable of integrating with a variety of Version Control (VC) / Software Configuration
Management (SCM) tools such as Git, Subversion, CVS and TFS. This allows you to browse the source
code repositories using the SpiraTeam web interface, and more importantly link revisions in these tools to
artifacts in SpiraTeam. This provides the end-to-end traceability from code commits/check-ins to the
tasks, incidents and requirements that necessitated the code change.

The information on using the various version control providers for SpiraTeam® and the steps for
configuring the provider-specific settings are described in the SpiraPlan/Team Version Control Integration
Guide.

To configure a version control provider, you need to click on the Administration > Integration > Version
Control link in the Administration navigation to bring up the list of configured version control providers:
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By default the only provider listed will be the TestVersionControlProvider which is used for demonstration
purposes only, and can be deleted from a production system by clicking on the “Delete” button to the right

of it.

To add a new version control provider, click the “Add” button to enter the Plug-in details page. The fields
required are as follows:

¢ Name: The name of the version control provider that you’re adding. This needs to match the
name of the Plug-in DLL file that you’re using (see the SpiraPlan/Team Version Control
Integration Guide for more details on your specific tool)

o Description: The description is for your use only, and does not affect operation of the plug-in.

e Active: If checked, the plug-in is active and able to be used for any project.




e Connection Info: This field holds the root of the repository for any project accessing the plug-in,
unless overridden in the Project Settings. Use the syntax that is described for your tool in the
SpiraPlan/Team Version Control Integration Guide)

e Login/ Password: The user id and the password of the user to use while accessing and
retrieving information from the version control system.

e Other Fields: The other fields (Domain, Custom1 — Custom5) are provider-specific and will be
described in the appropriate section of the SpiraPlan/Team Version Control Integration Guide.

When finished, click the “Insert” button and you will be taken back to the Version Control integration list
page, with new provider listed as an available plug-in:

Version Control Integration

Spiraleam is able to integrate with a variety of external version control systems using its flexible, open architecture and
library of available version control providers.

This page allows you to view, add and modify the list of version control providers, make changes to their configuration and
also specify any project-specific configuration values:

The Source Code cache is up to date.

Provider Description Project Settings Active Operations
SubversionControl Project Settings  Yes (& Edit = X Delete

Thi ides the d i trol
TestVersionControlProvider2 15 Provides fhe cummy version comtro

To edit the settings for an existing version control provider, click on the “Edit” button next to the name of

the provider and you will be able to edit the same settings that were shown above when you first created
it.

) . . Project Settings  Yes & Edit = X Delete
provider used in testing

Now, you may want to change some of the settings on a per-project basis. For example you may have
different repositories that you want to link to each project. You still enter the base settings for the provider
as illustrated above, but then you can override specific settings for each project.

To do this, click on the “Project Settings” button next to the provider in question:
SubversionControl Project Settings Library Information System
€ Back to Version Control Home | & Change Project

Please edit the following project-specific settings for the 'SubversionControl’ version control provider. If you leave any fields
blank, then the value will be taken from the provider’s default settings. To stop using this provider on the project, just set the
Active flag to No below:

Project Name:* Library Information System

Active for Project:” No

Clear Cache Cancel
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The first thing you need to do (regardless of whether you’ll be overriding any of the settings) is to make
the provider active for the current project. To do this, change the toggle to “Yes” and click [Save]:

Now you can decide whether you want to override any of the default settings for this project. Any field left
blank will automatically get its settings from the default values entered earlier. In the example above, we
have specified a project-specific repository path, login and password. Once you have correctly configured
the project, click [Save] to commit the changes.

To improve performance, SpiraTeam will cache some of the data it receives from the version control
provider. Normally SpiraTeam will know when to update the cached data based on changes made in the
version control system automatically. However sometimes you may wish to flush the cached data
completed, to do this, click on the [Clear Cache] button.

You are now ready to use SpiraTeam® in conjunction with the version control tool you selected. For
details on how to use the Source Code integration features of SpiraTeam, please refer to the
SpiraTeam® User Manual.

3.11.3. Test Automation

SpiraTeam® can be used to manage the development, scheduling and execution of automated unit,
functional and load tests written using a variety of test automation engines (e.g. HP QuickTest Pro,
SmarteScript, TestComplete, etc.). This section allows you to configure the different engines that are
available in your environment so that the testers know which tools they can use to schedule tests with.
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The information on using the various test automation engines for SpiraTeam® and the steps for
configuring the engine-specific settings are described in the SpiraTest/Team RemoteLaunch Automated
Testing Integration Guide.

To configure a test automation engine, you need to click on the Administration > Integration > Test
Automation link in the Administration navigation to bring up the list of configured test automation engines:

Test Automation Engines

SpiraTeam is able to integrate with a variety of external test automation systems using its flexible, open architecture and library of available test
automation engines.

This page allows you to view, add and modify the list of test automation engines and make changes to their configuration:

Name Token Description Active Operations

Bad Boy BadBoy?2 Engine that integrates with Bad Boy No @ Edit = % Delete
Command-Line CommandLine Engine that will execute a generic command-line executable No & Edit X Delete
FitNesse FitNesse Engine that integrates with FitNesse framewark No & Edit X Delete
IBMRFT RTFAutomationEngine Engine that integrates with IBM Rational Functional Tester No & Edit X Delete
IMeter IMeter2 Engine that integrates with Apache JMeter No & Edit X Delete
LoadRunner LoadRunnerll Engine that integrates with HP LoadRunner 11.0+ No & Edit X Delete
MNeoload Neoload Engine that integrates with NeoTys Neoload Yes & Edit X Delete
Quick Test Pro QuickTestPro% Engine that integrates with HP Quick Test Pro 9.0+ Yes & Edit X Delete
Ranorex RanorexEngine Engine that integrates with Ranorex No & Edit X Delete
Rapise Rapise Engine that integrates with Inflectra Rapise Yes & Edit X Delete
Selenium WebDriver  Selenium2 Engine that integrates with Selenium 2.0 WebDriver Yes & Edit X Delete
SmarteScript SmarteScripts Engine that integrates with SmarteSoft SmarteScript 5.5+ No & Edit X Delete
SOAP-UI SoapUI Engine that integrates with SmartBear SOAP-UI No & Edit X Delete
TestComplete TestComplete11 Engine that integrates with SmartBear TestComplete 11.0+ No & Edit X Delete
TestPartner TestPartner Engine that integrates with MicroFocus TestPartner No & Edit X Delete

To add a new test automation engine, click the “Add” button to enter the Automation Engine details page.
The fields required are as follows:




o Name: The name of the test automation engine that you're adding. This can be set to any name
of your choice that would make sense to your users.

e Description: The description is used for any comments or additional information that you need to
use to describe the automation engine.

e Active: If checked, the automation engine is active and able to be used in any project.

o Token: This needs to match the name of the Automation Engine DLL file that you're using (see
the SpiraTest/Team Automated Testing Integration Guide for more details on your specific tool)
for the specific automation engine.

When finished, click the “Insert” button and you will be taken back to the test automation engine list page,
with new automation engine listed.

To edit the settings for an existing test automation engine, just click on the “Edit” link next to the name of
the engine and you will be able to edit the same settings that were shown above when you first created it.

Once you have made the appropriate changes, click the [Save] button to commit them.
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You are now ready to use SpiraTest® / SpiraTeam® in conjunction with the test automation engine you
added. For details on how to use the test automation features of SpiraTeam, please refer to the
SpiraTeam® User Manual.

3.1.0.4. TaraVault™ Integration
This section refers to the functionality available to hosted/cloud customers of SpiraTeam. If you are using
the on-premise version of SpiraTeam, please refer to section 3.11.2 (Version Control Integration) instead.

TaraVault™ is the hosted source code repository and software configuration management (SCM) system
provided by Inflectra. When you signed-up or purchased a subscription to either SpiraPlan or SpiraTeam,
it will have come with an entry-level subscription to TaraVault.

When you first click on the Administration > TaraVault administration page, you will see the following
screen:

This lets you know that you have not yet activated your TaraVault account with Inflectra. When you click
on the [Activate TaraVault] button you will see the following:
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This will let you see how many TaraVault SCM users your subscription allows and also the name of the
TaraVault instance that your SpiraTeam instance is associated with.

Each project in SpiraTeam has its own corresponding TaraVault project, and each TaraVault project can
be configured to use one of the two different SCM providers:

e Subversion (SVN) — This is a simple, centralized version control system (VCS) that works best
for teams that want to have a centralized SCM environment with only one central instance of the
SCM repository. Subversion only allows a single branch to be managed and is generally easier to
understand conceptually.

e Git— This is a more powerful, distributed version control system (DVCS) that works best for
teams that want to have multiple distributed instances of their source code repository. Git offers
superior merging and branching functionality to Subversion but is generally more complicated to
understand conceptually.
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For the current SpiraTeam project you can choose the type of provider you wish to use, enter the name of
the TaraVault project and click Activate:

Since you cannot change the type or name of the TaraVault project once activated, please review your
entries and click [OK] to confirm the new project activation.

Once the project activation has been completed, the screen will display the following:

The screen will display the name of the linked TaraVault project as well as the list of TaraVault SCM
users that are configured to use this TaraVault project — this list will not necessarily be all of the users in

the SpiraTeam project, just those that need to connect to TaraVault to commit source code into the
repository.

If you want to deactivate this TaraVault project, click the [Deactivate] button and the project will be
removed from TaraVault.

To improve performance, SpiraTeam will cache some of the data it receives from TaraVault. Normally
SpiraTeam will know when to update the cached data based on changes made in TaraVault
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automatically. However sometimes you may wish to flush the cached data completed, to do this, click on
the [Clear Cache] button.

To add new SCM users to the TaraVault project, click on the ‘Add Users’ link to add new SCM users to
the project.

3.11.5. Add-Ons and Downloads

In addition to the web interface that is typically used to interact with SpiraTeam®, there are a variety of
downloadable tools and extensions that allow SpiraTeam® to be used in conjunction with other
applications, and also to enable the migration of data from other systems into SpiraTeam®.

To view the list of available add-ons and downloads, click the “Add-Ons and Downloads” link in the
Administration navigation sidebar and you will be taken to the page on the Inflectra® website that lists the
various add-ins for the system, together with links to the appropriate documentation.




4. Appendices

4.1. Appendix A — Troubleshooting

If you receive the dreaded “IIS 500 Internal Error” or the “Server Application Not Available” webpage
when you try and access SpiraTeam® for the first time, there can be a myriad of causes. However a good
first place to look for the cause is inside the Windows Event Viewer, which stores all errors raised in the
system.

To open the Event Viewer, click Start > Settings > Control Panel > Administrative Tools > Event Viewer.
This will open up the event viewer:

H Event Viewer = @
File Acton View Help
& = = B 2

@ Event Viewer (Local)
i8] Application

. MName Type Description Size
3| Security — )
i| System @Enpplimﬁon Log Application Error Records S512.0FE |
i4] Internet Explorer Security Log Security Audit Records 64.0KB
System Log System Error Records 128.0 KB
Internet Explorer Log Custom Log Error Records

Click on the Application and System folders in turn and look for errors raised by “MSSQLSERVER?”,
“SpiraTest”, “SpiraTest DataSync Service”, “DCOM”, “ASPNET” or “lIS”. Click on the error message, and
copy the text of the message into a text editor (e.g. Notepad).

Before contacting Inflectra® customer support with the specific error message, here are a couple of
common causes for the above errors together with the appropriate resolutions:

> The ASP.NET process account has been disabled (Windows XP only)
Go to Start > Control Panel > Administrative Tools > Computer Management and launch the
Windows computer management console. Expand Local Users and Groups > Users and then
double-click on the '"ASPNET' account. Make sure that the ASPNET user is not disabled.
This only applies to installing SpiraTeam on Windows XP. For other versions of Windows, the
ASPNET user is set per-application pool and typically is set to the built-in NETWORKSERVICE
account, so this won’t apply.

>» The ASP.NET process account does not have sufficient permissions
Right-click on the C:\WINDOWS\Microsoft. NET\Framework\v4.0.30319 folder (and any other
versions of .NET that are listed) and make sure that the ASPNET, NETWORKSERVICE and
LOCALSERVICE accounts are all listed with Full Control. If that doesn’t fit the issue and you are
using Windows Server, open up the IS manager and right-click on the Application Pool that
SpiraTeam® is running under and make sure that the identity listed has Full Control permissions
on the same folders.

» The Windows Event Log is full
Open up the Application and System event logs, right-click on the log name and choose
Properties. Make sure that both are set to “overwrite events as needed”. If they are not set to
overwrite as needed, change the setting then manually clear both logs.

If the resolutions above were not able to resolve the issue, please send an email to
support@inflectra.com and include the error message from both the web page and the Windows Event
Logs.
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4.1.1. Missing MSDTC Issue

There is one common error that has been found with installations where Microsoft SQL Server was
installed after IS was installed. This typically affects only Windows XP Professional, but could occur in
other situations. What happens is that the SQL Server installation inadvertently removes the Microsoft
Distributed Transaction Coordinator (MSDTC) service from the system during the installation.

To determine if this is indeed the cause of the observed error, you need to click on Start > Settings >
Control Panel > Administrative Tools > Component Services:

Once the window has opened, expand the folders marked “Component Services”, “Computers”, “My
Computer” and “COM+ Applications” in turn. If the window opens correctly and displays the information
illustrated above, then your IS 500 error is being caused by something else.

However if you receive an error message that indicates an inability to connect with the “Distributed
Transaction Coordinator”, then you have to fix the MSDTC service to enable 1IS and ASP.NET to operate

properly.
To fix the issue, you need to make changes to the Windows System Registry (hereafter referred to as “the

registry”). This is a process that should not be attempted by novice users, since any incorrect changes
can complete wreck the Windows installation, requiring a complete reinstallation of the operating system.

To open the registry, click Start > Run, and type “Regedit.exe” into the dialog box, and the registry will
open:

& Registry Editor
File Edit View Favorites Help

-1 MSDAIPP Al Name Type —
2 £ MsDN [Default) REG_SZ (value not set)
i a AIIDWOnIySecureRchalls REG_DWORD 0x00000001 (1)
: g :zficensing Clustering\.l'ersion REG_DWORD Ox At (4294967295)
-] MsMQ FaIIbadﬁToUnsecureRPCIﬁ\l... REG_DWORD 0x00000000 (0)
- (27 MSNInstaller MaxLogSize REG_DWORD 0x00000200 (512)
T D MSOSOAP TurnOFprcSecurity REG_DWORD 0x00000000 {0)
*-(L] M55QLServer v
< > < >

My Computer \HKEY_L OCAL_MACHINENSOFTWARE WMicrosoft\MSDTC

Expand the folders marked “My Computer”, “HKEY_LOCAL_MACHINE”, “SOFTWARE” and “Microsoft” in
turn and navigate to the folder marked “MSDTC". Click the “Delete” button on your keyboard, and click
“OK” on the confirmation box. Now close the registry editor.

Now you need to click on Start “Settings > Control Panel > Add or Remove Programs and click on the tab
marked “Add/Remove Windows Components”:
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Windows Components Wizard

Windows Components

*ou can add or remove componerts of Windows XP.

To add or remove a component, click the checkbox. A shaded box means that onby
part of the component will be installed. To see what's included in @ component, click

Details.

Components:

~
(%4 Fax Services 3.8 MB

FP Indexing Service 0.0 MB

& Intemet Explorer 0.0 ME

W & Intemet Infomation Services (11S) 126MR ¥

Description: Includes Windows Accessories and Lkilities for your computer.

Total disk space required: 56.3 MB -
38370.1 MB __Detalls...

Space available on disk:

[ < Back " Mext = ] [ Cancel ]

Don’t change any of the selected components, but instead simply click the “Next” button. The Windows
installer will detect that the MSDTC is missing (due to the registry change you made) and will now
reinstall it correctly. Once this has finished, reboot the system and you should now be able to access ASP
and ASP.NET applications from within IIS.

4.1.2. Application Session Pooling Issues (IIS 6.0)

This issue can affect Windows Server 2003 using IS 6.0. Since the 6.0 release of IIS, there is the ability
to separate the web-server into different “Application Pools”. Sometimes, web hosting companies will host
multiple websites in the same application pool (which we do not recommend). When resources are
maxed out for an application pool IIS 6 starts to recycle these sites causing application variables to be
lost for those recycled sites. By default, SpiraTeam installs on these operating systems in its own
application pool.

If you are experiencing application/session loss symptoms then we recommend asking your web
hosting company to verify that your instance of SpiraTeam is running in its own application pool with all
recycling options disabled and the recycle worker process set to recycle only once during the day at a set
time.

To make these changes yourself, you need to follow these steps:

1) Add new application pool for “SpiraTeam” if one does not already exist:

2) Next, choose your own application pool in the SpiraTeam web site properties:
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Default Web Site Properties ? &

Directory Security HTTP Headers Zuskom Errors ASP.MNET
‘Web Site Performance ISAPI Filters Home Directary Docurnents

The content For this resource should come from:

() A share located on anather computer
O & redirection ta a URL

Local path: cihinetpubienansroot
[] Script source access Log wisits

Read Index this resource

Ll uiree Choose the application

[ birectary browsing

Application settings

poolyoucreated before

Application name: Default application ’
Starting point: =Default web Sited
Configuration. ..
Execute permissions: Seripks only rd dl
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Click “OK” and you should now find that the issues with sessions disappearing has been corrected.

4.1.3. Application Session Pooling Issues (IIS 7.0+)

This issue can affect Windows Vista, 7, 8 or Server 2008, 2012 using IIS 7+. In IS 7.0+, there is the
ability to separate the web-server into different “Application Pools”. Sometimes, web hosting companies
will host multiple websites in the same application pool (which we do not recommend). When resources
are maxed out for an application pool IIS 7 starts to recycle these sites causing application variables to be
lost for those recycled sites. By default, SpiraTeam installs on these operating systems in its own
application pool.

If you are experiencing application/session loss symptoms then we recommend asking your web
hosting company to verify that your instance of SpiraTeam is running in its own application pool with all
recycling options disabled and the recycle worker process set to recycle only once during the day at a set
time.

To make these changes yourself, you need to follow these steps:

Add new application pool for “SpiraTeam” (if one does not already exist) and make sure it is set to use the
.NET Framework v4.0 and the “Integrated Pipeline”:

Next, choose your own application pool in the SpiraTeam web site properties:
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Legal Notices

This publication is provided as is without warranty of any kind, either express or implied, including, but not
limited to, the implied warranties of merchantability, fitness for a particular purpose, or non-infringement.

This publication could include technical inaccuracies or typographical errors. Changes are periodically
added to the information contained herein; these changes will be incorporated in new editions of the
publication. Inflectra® Corporation may make improvements and/or changes in the product(s) and/or
program(s) and/or service(s) described in this publication at any time.

The sections in this guide that discuss internet web security are provided as suggestions and guidelines.
Internet security is constantly evolving field, and our suggestions are no substitute for an up-to-date
understanding of the vulnerabilities inherent in deploying internet or web applications, and Inflectra®
cannot be held liable for any losses due to breaches of security, compromise of data or other cyber-
attacks that may result from following our recommendations.

The section of the manual that describes modifying the Windows System Registry (“Registry”) should only
be attempted by experienced Windows administrators who are familiar with its organization and contents.
Inflectra® cannot be held liable for any losses due to damage to the system registry made by
inexperienced personnel.

SpiraTest®, SpiraPlan®, SpiraTeam® and Inflectra® are registered trademarks of Inflectra Corporation in
the United States of America and other countries. Microsoft®, Windows®, Explorer® and Microsoft
Project® are registered trademarks of Microsoft Corporation. All other trademarks and product names are
property of their respective holders.

Please send comments and questions to:
Technical Publications
Inflectra Corporation
8121 Georgia Ave
Suite 504
Silver Spring, MD 20910
U.S.A

support@inflectra.com
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